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User Manual

About this Manual

This Manual is applicable to Guarding Vision Client Software.

The Manual includes instructions for using and managing the product. Pictures, charts, images and
all other information hereinafter are for description and explanation only. The information
contained in the Manual is subject to change, without notice, due to firmware updates or other
reasons. Please find the latest version in the company website.

Please use this user manual under the guidance of professionals.

Legal Disclaimer

REGARDING TO THE PRODUCT WITH INTERNET ACCESS, THE USE OF PRODUCT SHALL BE WHOLLY AT
YOUR OWN RISKS. OUR COMPANY SHALL NOT TAKE ANY RESPONSIBILITES FOR ABNORMAL
OPERATION, PRIVACY LEAKAGE OR OTHER DAMAGES RESULTING FROM CYBER ATTACK, HACKER
ATTACK, VIRUS INSPECTION, OR OTHER INTERNET SECURITY RISKS; HOWEVER, OUR COMPANY WILL
PROVIDE TIMELY TECHNICAL SUPPORT IF REQUIRED.

SURVEILLANCE LAWS VARY BY JURISDICTION. PLEASE CHECK ALL RELEVANT LAWS IN YOUR
JURISDICTION BEFORE USING THIS PRODUCT IN ORDER TO ENSURE THAT YOUR USE CONFORMS THE
APPLICABLE LAW. OUR COMPANY SHALL NOT BE LIABLE IN THE EVENT THAT THIS PRODUCT IS USED
WITH ILLEGITIMATE PURPOSES.

IN THE EVENT OF ANY CONFLICTS BETWEEN THIS MANUAL AND THE APPLICABLE LAW, THE LATER

PREVAILS.
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Chapter 1 Overview

1.1 Description

Guard Vision is a versatile video management software for the DVRs, NVRs, IP cameras, encoders, etc.
It provides multiple functionalities, including real-time live view, video recording, remote search and
playback, alarm receiving, etc., for the connected devices to meet the needs of monitoring task. With
the flexible distributed structure and easy-to-use operations, the client software is widely applied to
the surveillance projects of medium or small scale.

This user manual describes the function, configuration and operation steps of Guarding Vision
software. To ensure the properness of usage and stability of the software, please refer to the

contents below and read the manual carefully before installation and operation.

1.2 Running Environment

Operating System: Mac OS X 10.9 to 10.12
CPU: 3.00 Ghz Intel Dual-Core or above
Memory: 1G or above

Video Card: NVIDIA Geforce 9400 or above
GPU: 256 MB or above

1.3 Function Modules

Control Panel of Guarding Vision:

a Guarding Vision Aa-0oXx
Control Panel
- S aadl
%z = P & O
3k | f |
Main E Event Remote iroup Log
View Playback Management Search
Account Device Snrﬁ Stream
Management Management Server Ma... Media Ser...
2 £
e [
v |
Camera System
Settings Configuration
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Menu Bar:
@ Client File System View Tool Help
. Click to view the client version and view the
About Client . .
Client manageable device quantity.
Quit Client Click to exit the client.
Enter the Capture page to select the folder location of
Open Captured Picture ) ]
the exported captured picture file (s).
Enter the video player and select the folder location of
File Open Video File the exported video file (s), You can also capture
pictures during the playing of the video file.
. Enter the Log File page to select the folder location of
Open Log File .
the exported log file (s)
o Lock screen operations. Log in the client again to
oc
unlock.
Switch User Switch the login user.
System —— —
System Configuration Open the System Configuration page.
Import Configuration File | Import client configuration file from your computer.
Export Configuration File Export client configuration file to your computer.
1024*768 Display the window at size of 1024*768 pixels.
1280*1024 Display the window at size of 1280*1024 pixels.
Most Adaptive Screen Display the window in most adaptive mode.
Control Panel Enter Control Panel page.
View
Main View Open Main View page.
E-map Open E-map page.
Event Search Open Event Search page.
Remote Playback Open Remote Playback page.
Group Management Open the Group Management page.
Camera Settings Open the Camera Setting page.
Account Management Open the Account Management page.
Device Management Open the Device Management page.
Tool Storage Server
Open the Storage Server Management page.
Management
Stream Media Server
Open the Stream Media Server Management page.
Management
Device Arming Control Set the arming status of devices.
Open Wizard Open the guide for the client configuration.
Help Click to open the User Manual; you can also open the
User Manual

User Manual by pressing F1 on your keyboard.

The Guarding Vision client software is composed of the following function modules:

-

The Main View module provides live view of network cameras and video encoders, and

supports some basic operations, such as picture capturing, recording, PTZ control, etc.

5
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X

The E-map module provides the displaying and management of E-maps, hot regions and

hot spots.

The Event Search module provides searching and playing back the alarm video file of

motion detection and alarm input.

c®

The Remote Playback module provides the search, playback, export of video files.

The Camera Management module provides adding, modifying, or deleting the camera
groups, and importing/exporting cameras to the groups.

The Log Search module provides the query of alarm logs, operation logs, and system logs
and the log files can be filtered by different types.

The Account Management module provides the adding, modifying, and deleting of user

accounts and different permissions can be assigned for different users.

The Device Management module provides the adding, modifying and deleting of

different devices.

The Storage Server Management module provides adding, modifying, or deleting the

storage server.

BERnP

The Stream Media Server Management module provides adding, modifying, or deleting

the stream media server.

LY
1 'Y

\

The Camera Settings module provides configuring camera parameters (e.g., image

quality, recording schedule, motion detection, etc.).

0
RN

The System Configuration module provides the configuration of the general parameters

(e.g., saving path of files, alarm sound, Email, etc.).

The function modules are easily accessed by clicking the navigation buttons on the control panel or by

selecting the function module from the View or Tool menu.

1.4 Updates Instruction

Multiple newly-designed functions are offered in the latest Guarding Vision client software. You can

get a brief view of the updates instruction from the following contents..

Add Device via Guarding Vision Domain

Support adding device via Guarding Vision Domain.

View Online Status after Adding Device

Support viewing the online status after adding devices.

Perform Live View and Playback in Full Screen Mode

Support viewing live video and playing video files in full screen mode.

Customize Window Division for Live View and Playback

Support setting a custom window division for live view and playback.

Auto-change Stream Type

Support switching stream type automatically.

Encrypt for Email

Support setting encryption for email.

Improve Security

Encrypt the database sensitive information.
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Chapter 2 User Registration and Login

For the first time to use Guarding Vision client software, you need to register a super user for login.
Steps:
1. Input the super user name and password.

We highly recommend you to use a strong password to ensure your data security.

Confirm the password.

(Optional) Check Enable Auto-login checkbox to log in to the software automatically.

Click Register.

Then, you can log in to the software as the super user.

Register Administrator

Please create a super user before proceeding.

Super User:

Password:

Confirm:

[ Enable Auto-login

Register Cancel

® A user name cannot contain any of the following characters: /\ : * ? “< > [. And the length
of the password cannot be less than 6 characters.

®  For your privacy, we strongly recommend changing the password to something of your own
choosing (using a minimum of 8 characters, including upper case letters, lower case letters,
numbers, and special characters) in order to increase the security of your product.

®  Proper configuration of all passwords and other security settings is the responsibility of the

installer and/or end-user.

When opening Guarding Vision after registration, you can log in to the client software with the
registered user name and password.

Steps:

1. Inputthe user name and password you registered.

2. Optionally, check Enable Auto-login checkbox to log in to the software automatically.

3. Click Login.
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User Name: admin b4

Password: |

[ Enable Auto-login

Login Cancel

After running the client software, a wizard will open to guide you to add the device and do some

basic settings.
Welcome to the Guarding Vision client software.

This wizard helps you add device to the software and import the added devices into a group.

Enter Wizard Cancel

Click Enter Wizard to start the wizard and add the device, or click Cancel to exit the wizard.
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Chapter 3 Device Management

3.1 Adding the Device

Purpose:

After running the Guarding Vision, you can add the devices, including network cameras, DVRs, NVRs,
etc., to the client for the remote configuration and management, such as live view, playback, alarm
settings, etc.

Perform the following steps to enter the Device Management page.

Click =8 on the control panel, or click Tools->Device Management to open the Device
Management page.

© Add 2 Modify 1 Delete 4 Remote Configuration  Show Online Devices
Nickname 1P address Serial No. Security Net Status
camera 101335144  DS-2CD5066G... Weak

IP dome 10.15.6.250

3.1.1 Activating Device

Purpose:

For some devices, you are required to create the password to activate them before they can be

added to the software and work properly.

Note: This function should be supported by the device.

Steps:

1. Enter the Device Management page.

2. Inthe device list, check the device status (shown on Security column) and select an inactive
device.
Or you can click Show Online Devices button to open the following page.

All the online devices are displayed in the device list.
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Show Online Devices X

Index  Added Device Type Security P Port Seri
001 No DS-7932N-K4 Active 10.17.137.240 8000 DS- MACAddress:
002  No DS-KH8301-A  Active 10.17.137.250 8000 DS Software Version: 3.4.92build 170517
003 No TVR4508HD Active 10.17.137.107 8000 TR Device ID:
004 No TVN1004cS Active 10.17.137.243 8000 TVN
[DS-7932N-K4162016123OCCRR7028192
005 No DS-2DF8823IV-A  Active 10.17.137.245 8000 Ds-
006 No DS-2CD2712F... Active 10.17.137.229 8000 Ds-
007 No DS-2DF7286-A  Active 10.17.137.248 8000 Ds-
008  No DS-3E1328 Active 10.17.137.188 8000  DS- |paddress: 1017 137 240
009 No DS-2DM71201-A  Active 10.17.137.253 8000 Ds- Subnet Mask: 255.255.255.0
010 No DS-2DE4182-A3  Active 10.17.137.247 8000 Ds-
Port: 8000
Please Input Administrator Password:
Modify
<l >l Restore
Refresh every 15s Activate Select Device Exit

Select the inactive device.
Click Activate to open the Activation page.

Create a password in the password field, and confirm the password.

STRONG PASSWORD RECOMMENDED- We highly recommend you create a strong password of

your own choosing (using a minimum of 8 characters, including upper case letters, lower case

letters, numbers, and special characters) in order to increase the security of your product. And
we recommend you reset your password regularly, especially in the high security system,
resetting the password monthly or weekly can better protect your product.

User Name: admin

Password: (

Confirm Password:

OK Cancel

6. Click OK to create the password for the device.
A “The device is activated.” window pops up when the password is set successfully.
After activating the device, the Safe Status of the device will turn to Active.
In the Show Online Devices page, select the activated device and you can edit its network
parameters.
Note: This function is only available on the Show Online Devices window. You can change the device
IP address to the same subnet with your computer if you need to add the device to the software.
Steps:
1. Change the device IP address to the same subnet with your computer by modifying the IP
address manually.

2. Edit the subnet mask and port No. according to the actual needs.

10
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3.

Input the password set in step 4 and click Modify to complete the network settings.

3.1.2 Adding Online Devices

Purpose:

The active online devices in the same local subnet with the client software will be displayed in the

Show Online Devices page. You can click the Refresh every 15s button to refresh the information of

the online devices.

Add Single Device

Steps:
1. Click Show Online Devices button to open Show Online Devices window.
All the active online devices in the same local subnet with the client software will be displayed.
2. Select one device.
Note: For the inactive device, you need to create the password for it before you can add the
device properly. For details, please refer to Chapter 3.1.1 Activating Device.
3. Click Select Device, and click OK in the pop-up window to open Add Device window.
(e IP/Domain (" Guarding Vision (" 1P Server (" HIiDDNS
Nickname: {
Address: [10.47.137.240
Port: [3000
User Name: {
Password: [
[V Export To Group
Show Online Devices Add Cancel
4. Input the required information.

Nickname: Edit a name for the device as you want.

Address: Input the device’s IP address. The IP address of the device is obtained automatically in
this adding mode.

Port: Input the device port No.. The default value is 8000.

User Name: Input the device user name. By default, the user name is admin.

Password: Input the device password.

The password strength of the device can be checked by the software. For your privacy, we
strongly recommend changing the password to something of your own choosing (using a
minimum of 8 characters, including upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your
password regularly, especially in the high security system, resetting the password monthly or
weekly can better protect your product.

11
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5. (Optional) Check Export to Group checkbox to create a group by the device name.
All the channels of the device will be imported to the corresponding group by default.
6. Click Add to add the device.

Add Multiple Devices

Steps:
1. Click Show Online Devices button to open Show Online Devices window.
All the active online devices in the same local subnet with the client software will be displayed.
2. Select devices you want to add.
Note: For the inactive device, you need to create the password for it before you can add the
device properly. For details, please refer to Chapter 3.1.1 Activating Device.

3. Click Select Device, and click OK in the pop-up window to open Add Device window.

Add Device b

User Name: [

Password: [

[ Export To Group

Add Cancel

4. Input the required information.
User Name: Input the device user name. By default, the user name is admin.

Password: Input the device password.

The password strength of the device can be checked by the software. For your privacy, we
strongly recommend changing the password to something of your own choosing (using a
minimum of 8 characters, including upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your
password regularly, especially in the high security system, resetting the password monthly or
weekly can better protect your product.

5. (Optional) Check Export to Group checkbox to create a group by the device name.
All the channels of the device will be imported to the corresponding group by default.

7. Click Add to add the devices.

Modify Network Information

In the Show Online Devices page, select the activated device and you can edit its network
parameters in the Network Info area.

Steps:

1. Change the device IP address, subnet mask, and port No. according to the actual needs.
2. Input the administrator password of the device.

3.  Click Modify to complete the network settings.

Reset Device Password
12
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You can reset the device password in the Show Online Devices page.
According to the different devices, the software provides two different methods for restoring the
default password or resetting the password.
Select the device from the list, click Restore.
Option 1:
If the window with security code field pops up, input the security code, and then you can restore the
default password of the selected device.
Note: The security code is returned after you send the serial No. of the device to the manufacturer.
Option 2:
If the window with import file and export file buttons, password and confirm password field pops up,
follow the steps below to reset the password:
1. Click Export to save the device file on your PC.
2. Send the file to our technical engineers.
3. Our technical engineer will send you a file to you.
Click Import button and select the file sent by the technical engineer and import it.
4. Input new password in text fields of Password and Confirm Password.

Click OK to reset the password.

The password strength of the device can be checked by the software. For your privacy, we
strongly recommend changing the password to something of your own choosing (using a
minimum of 8 characters, including upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your
password regularly, especially in the high security system, resetting the password monthly or

weekly can better protect your product.

3.1.3 Adding Devices by IP or Domain Name

Steps:
1. Inthe Device Management page, click Add to open Add Device window.

2. Select IP/Domain as the adding mode.

(e IP/Domain (" Guarding Vision (" IP Server (  HIDDNS

Nickname:

Address:

Port: [ 8000
User Name: 'admm

Password:

[v Export To Group

Show Online Devices Add Cancel

3. Input the required information.

13
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Nickname: Edit a name for the device as you want.

Address: Input the device’s IP address or domain name.

Port: Input the device port No.. The default value is 8000.

User Name: Input the device user name. By default, the user name is admin.

Password: Input the device password.

The password strength of the device can be checked by the software. For your privacy, we
strongly recommend changing the password to something of your own choosing (using a
minimum of 8 characters, including upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your
password regularly, especially in the high security system, resetting the password monthly or
weekly can better protect your product.

(Optional) Check Export to Group checkbox to create a group by the device name.

All the channels of the device will be imported to the corresponding group by default.

Click Add to add the device.

3.14 Adding Devices by Guarding Vision

Purpose:

You can add the devices which have been added to the Guarding Vision account to the client.

Before you start: Add the devices to Guarding Vision account via Guarding Vision first. See the User

Manual of Guarding Vision Mobile Client for details.

Steps:
1. Inthe Device Management page, click Add to open Add Device window.
2. Select Guarding Vision as the adding mode.

(" IPDomain (e Guarding Vision (" IP Server (" HIiDDNS

Please login Guarding Vision account.
Country/Region: USA v
Login

Show Online Devices Add Cancel
3. Select the country or region.
4. Click Login to enter the Login page.

14
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Input the Guarding Vision account and password.
6. Click Login to log in to your account.
All the devices added in this account will display.
Note: The account information will keep 7 days. After 7 days, you are required to log in to the

account again.

Add Device x

(" IP/Domain (o Guarding Vision (" 1P Server (" HIDDNS
Current Account hee1122 Logout | Refresh  Searcr Q
[ Nickname P Serial No. Addec
[~ Ds 8660) Ds. C... No
[ DS 2418) DS R... No
[ DS 94) NV 4... No
User Name: ( Password:
[V Export to Group

Show Online Devices Add Cancel

7. Check the checkbox(es) to select the device(s).

Input the user name and password of the selected device(s).
9. (Optional) Check Export to Group checkbox to create a group by the device name.

All the channels of the device will be imported to the corresponding group by default.
10. Click Add to add the device(s).

3.1.5 Adding Devices by IP Server

Steps:
1. Inthe Device Management page, click Add to open Add Device window.

2. Select IP Server as the adding mode.

15
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(" IPDomain (" Guarding Vision (e IP Server (" HIDDNS

Nickname:
Server Address:
Device ID:

User Name: 'admln

Password:

v Export To Group

Show Online Devices Add Cancel

3. Input the required information.
Nickname: Edit a name for the device as you want.
Server Address: Input the IP address of the PC that installs the IP Server.
Device ID: Input the device ID registered on the IP Server.
User Name: Input the device user name. By default, the user name is admin.

Password: Input the device password.

The password strength of the device can be checked by the software. For your privacy, we
strongly recommend changing the password to something of your own choosing (using a
minimum of 8 characters, including upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your
password regularly, especially in the high security system, resetting the password monthly or
weekly can better protect your product.

4. (Optional) Check Export to Group checkbox to create a group by the device name.
All the channels of the device will be imported to the corresponding group by default.

5. Click Add to add the device.

3.1.6 Adding Devices by HIDDNS

Steps:
1. Inthe Device Management page, click Add to open Add Device window.
2. Select HIDDNS as the adding mode.
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| Add Device x
(" IPDomain " Guanding Vision ~ IP Server (e HIDDNS
Nickname:
Server Address: www.hiddns.com
Device Domain Name: |
User Name: ’admm
Password: ~  |"7T™"
[V Export To Group
Show Online Devices Add Cancel

3. Input the required information.
Nickname: Edit a name for the device as you want.
Server Address: www.hiddns.com.
Device Domain Name: Input the device domain name registered on HiDDNS server.
User Name: Input the device user name. By default, the user name is admin.

Password: Input the device password.

The password strength of the device can be checked by the software. For your privacy, we
strongly recommend changing the password to something of your own choosing (using a
minimum of 8 characters, including upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your
password regularly, especially in the high security system, resetting the password monthly or
weekly can better protect your product.

4. (Optional) Check Export to Group checkbox to create a group by the device name.
All the channels of the device will be imported to the corresponding group by default.

5. Click Add to add the device.

3.2 Group Management

Purpose:

The encoding devices added should be organized into groups for a convenient management. You can
get the live view, play the video files, and do some other operations of the device through the group.
Before you start:

Encoding devices need to be added to the client software for group management.

Click &8 on the Control Panel, or you can click Tool -> Group Management to enter the Camera
Group page as follows.
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[E1 10.16.6.126

& 10.16.6.126

o Import
Import All

Select Device Group
Al " € Add & Modify T Delete
U 172.10.18.129 =) 7 =
- [7) 10.33.3.159 ~
s = @ 10.33.3.159_Camera01
@& 10.33.3.159_Camera02
@& 10.33.3.159_Camera03
& 10.33.3.159_Camera04
9 172.10.18.125 IR [=) speed dome

Adding Group

Steps:
1. Click Add on the Group List on the right to open the Add Group window.
2. Input a group name as you want.

3. Click OK to add the new group to the group list.

Name:

OK Cancel

Importing Camera to Group

Steps:

1. Inthe Select Device panel on the left, click to select the device and the thumbnails of the

cameras of the device will be displayed below.

Note: You can click Add Device to add a new device. For details, refer to Chapter 3.1 Adding the

Device.

2. Select the thumbnails of the cameras.

You can double-click the thumbnail of the camera to view the live video of the camera.

Select a group from the group list.
Click Import to import the selected cameras to the group.

You can also click Import All to import all the cameras to the selected group.

Note: Up to 64 cameras can be added to one group, and up to 1024 cameras for all the groups

are allowed in total.
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Select Device Group
Al v i € Add Device v/ a © Add 2 Modify 10 Delete
© 17210.18.129 . =
.10.18. ¥

£ 10.33.3.159 N

© 1033.3.159
& 10.33.3.159_Camera01

@ 10.33.3.159_Camera02

@ 10.33.3.159_Camera03

@ 10.33.3.159_Camera04

¥ )\ £ 10.16.6.126 ~

- @ 10.16.6.126_Camera01

) 172.10.18.125

O
1)
@
(1
S

0 10.16.6.126 2
Import
4
() Intersection §

The following buttons are available on the Select Device panel:

[ Modify Modify the connection parameters of the device.
(%) Delete Delete the device.
&Y Refresh Refresh the latest information of added cameras.

Create a group named as device name and import the
=9 Export to Group ]
device to group.

¥ Remote Configuration | Open the Remote Configuration window of the device.
%z | ¥ | | Fold All/Expand All Collapse/Expand all the thumbnails of cameras.
Al Fold/Expand Collapse/Expand the thumbnails of camera.

Modifying the Group/Camera

After adding the group and importing the camera to the group, you can edit the group name and the
imported camera name as desired.
Steps:
1. Select the group/camera from the group list on the right, and click Modify,
or double-click the group/camera name to open Modify Group/Camera window.
2. Edit the group/camera information, including the group/camera name, the stream type, etc.

3. Click OK to save the new settings.

Name: [ camera Name: [ camera_Camera01|

OK Cancel OK Cancel

Removing Cameras from the Group

Steps:
1. Click to select the imported camera from the group list.

2. Click Delete to remove the camera from the group.

Deleting the Group

Steps:
1. Select the group in the Group list on the right.
2. Click Delete, and click OK in the pop-up window to confirm the deleting.
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The selected group and the cameras under it will be deleted.
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Chapter 4 Camera Settings

Purpose:

Before remote playback, you should set the schedule first.

You can also configure the event (including motion detection alarm, tampering alarm, video loss) of
the device.

You can also configure the parameter for the image and video to get different performance for actual
needs.

Meanwhile, you can set the PTZ parameters and network connection parameters in this section.

I
Click ®= on the control panel to enter the Camera Settings page.

Set picture parameters of the device
(e.g., brightness, hue, contrast, saturation, etc.)

Contrast: ——a————

Default

Device Settings

Select the camera on the dropdown list on left side of the page, and the video image of that camera
will be displayed below.
Click on icons in the lower left area to enter different configuration pages, such as the image settings

page, the video quality setting page and so on.

]

Video picture parameters configuration

)

Video encoding quality configuration

1
-

Recording schedule configuration

Video display parameters configuration

i

Motion detection configuration

View tampering alarm configuration

<l

Video loss alarm configuration

*%%J
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PTZ configuration

Network parameter configuration for the camera

-
[ ==

Note: You can click Device Settings to enter the Remote Configuration page of the device. For details,

please refer to the user manual of the device.

4.1 Picture Settings

In Picture Settings page, you can adjust the brightness, contrast, saturation, and hue of the video
image.
Note: The available parameters may be different from the camera types.

Drag the slider to adjust the level from lowest to highest.

Set picture parameters of the device
(e.g., brightness, hue, contrast, saturation, etc.)

Brightness: —_—

Contrast: -————— s

Saturation: -———————— +
Default

You can click Default to restore default settings.

4.2 YVideo Settings

Purpose:

You can set video parameters, such as video quality, resolution, and other parameter settings.

Steps:
1. Click Video Settings to enter the Video Settings page.
Set image quality, resolution, and other parameters of the camera
Video Quality: Low  Middle High
Main Stream: 3072°1728 v Advanced Settings
File Size: 105.5G
Video Quality: Low  Middle High
Sub Stream: 4CIF(704°576) v Advanced Settings
File Size: 10.5G
Audio Encoding Type: G711_U v
Audio Input Type: line in v
Copy to ... Save

2. Setvideo parameters, including video resolution and video quality for main stream and sub
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stream separately.
You can click Advanced Settings to open Advanced Settings window and set the related

parameters, such as stream type, bitrate type, and so on.

Advanced Settings b

Stream Type: Video & Audio v
Bitrate Type: Variable v
Max Bitrate: Customize v
10240 Kbps

Frame Rate: Full Frame v
Frame Type: P v
| Frame Interval: 50

Encoding Type: STD_H264 v
Profile: Middle v

OK Cancel

3. Set the event parameters.
1) Check Enable Event Parameters checkbox.
2) Set the video quality and resolution for event video.
3) (Optional) Click Advanced Settings to open Advanced Settings window and set the related
parameters, such as stream type, bitrate type, and so on.
4) Click OK to save the settings.
Click Copy to to copy the settings to other cameras in the group.

Click Save to save the settings.

4.3 Schedule

Purpose:

When the video storage devices are the HDDs, Net HDDs, SD/SDHC cards on the local device, or the
remote storage server connected, you can set the recording schedule for the cameras for the
continuous, alarm triggered, or command triggered recording. And the video files can be searched
for the remote playback.

Click Schedule to enter the recording schedule page.

Set recording schedule of the camera.

Record
[V Local Recording
Recording Schedule: All-day Template

Advanced Settings

Storage Server Recording
Storage Server Management

[ Capture

Capture Schedule: Template 0

Copy to ... Save
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4.3.1 Storing on the DVR, NVR, or Network Camera

Purpose:

Some local devices, including the DVRs, NVRs, and Network Cameras, provide storage devices such
as the HDDs, Net HDDs and SD/SDHC cards for video files. You can set a recording schedule or

capture schedule for the channels of the local devices.

Before you start:

The newly installed storage devices need to be formatted. Go to the remote configuration page of

the device, click Storage->General, select the HDD or SD/SDHC card, and click Format to initialize the

selected storage device.

Steps:
1. Open the Schedule page in Camera Settings.
2. Select the camera in the Camera Group dropdown list.
3. Check Local Recording or Capture checkbox to enable device local recording or capture.
4. Select the recording or capture schedule template from the drop-down list.
® All-day Template: for all-day continuous recording.
® Weekday Template: for working-hours continuous recording from 8:00 AM to 8:00 PM.
® Alarm Template: for the alarm triggered recording.
® Template 01 to 08: fixed templates for specific schedules. You can edit the templates if
needed.
® Customized: can be customized as desired.
If you need to edit or customize the template, refer to Configuring Recording Schedule
Template
5.

Click Advanced Settings to set the recording parameters.

Advanced Settings
Pre-record: No PreRecord v
Post-record: 5s v
Video Expired Time: (o Day

Redundant Record:

Record Audio:

OK Cancel
Note: The displayed items vary with the devices.
Parameters Descriptions
Normally used for the event triggered record, when you want to record before
Pre-record
the event happens
Post-record After the event finished, the video can also be recorded for a certain time.

Video Expired Time

The time for keeping the video files in the storage device, once exceeded, the

files will be deleted. The files will be saved permanently if the value is set as 0.

Redundant Record Save the video files not only in the R/W HDD but also in the redundant HDD.

Record Audio Record the video files with audio or not.

6.

(Optional) Click Copy to... to copy the recording schedule settings to other channels.
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7.

Copy to X
Copy to:

[ A
[ 10.16.5.106_Camera01

10.16.5.106_Camera03
10.16.5.106_Camera04
10.16.5.106_IP Camera01

OK Cancel

Click Save to save the settings.

Configuring Recording Schedule Template

Perform the following steps to configure the recording schedule template:

If Template 01 to 08 is selected from the drop-down list, start from step 1;

If Customized is selected from the drop-down list, start from step 2.

1.

5.

Click Edit to edit the template and select the template to be set.
You can edit the template name.

Set the time schedule for the selected template.

& Schedulerecording | ofe s +o normal schedule record. The schedule time bar is marked with .

£ Event refers to the schedule record for the event. The schedule time bar is marked with
.
& Command | ofers to the schedule record triggered by command. The schedule time bar is
marked with

Note: Recording triggered by command is only available for the ATM transactions when the ATM

DVR is added to Guarding Vision.

(Optional) After setting the time schedule, you can perform the following operations to adjust

the time period.

® \When the cursor turns to , you can set the time period.

® When the cursor turns to ﬂ, you can move the selected time bar you just edited. You can
also edit the displayed time point to set the accurate time period.

®  When the cursor turns to -, you can lengthen or shorten the selected time bar.

(Optional) Delete or copy the time schedule.

Select the schedule time bar and click & to delete the selected time bar.

Select the schedule time bar and click m to delete all the time bars.

Select the schedule time bar and click I to copy the time bar settings to the other dates.
Click Save to save the settings.

Note: Up to 8 time periods can be set for each day in the recording schedule.
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(" Woekday Templ... [
Mon
(" Alarm Tempiate

g
s

1

;
8
g |

" Arday Tempiate &£ Schedule Recording

£ Event

3

oL S —————
~
e Wed 0 2 4 ] [ 0 1 U o6 W0 2 M
(" Tempiate 03 —
T o 2 4 ¢ s 0 2 W 6 W 0 2 M
Tomplate 04 e ————
(" Tempiate 05 Fioo 2 4 o [ O B R N I
- —
Template 05 aat 2 2

Tomplates

# Command L0me O W

3

Cancel

4.3.2 Storing on Storage Server

Purpose:

You can add storage device to the client for storing the video files of the added encoding devices and

you can search the files for remote playback. The storage device can be storage server, CVR (Center

Video Recorder) or other NVR. Here we take the settings of storage server as an example.

Before you start:

The storage server application software needs to be installed on other PC running Windows OS.

When installing the Guarding Vision, check Storage Server checkbox to enable the installation of

storage server.

Adding the Storage Server

To assign a Storage Server for the recording schedule, add at least one storage server to the client.

Steps:

1. Click on the desktop to run the storage server.

Notes:

® The Storage Server can only be installed on the PC running Windows OS.

® |f the storage server port (value: 8000) is occupied by other service, a window will open.

You should change the port No. to other value to ensure the proper running of the storage

server.

2. On the Guarding Vision Client, click ’ on the control panel to enter the Storage Server

Management page.

You can also click Storage Server Management in Schedule page of Camera Settings to enter the

Storage Server Management page.

© Add 2 Modify i Delete J# Remote Configuration Show Online Devices
Nickname P Serial No.
Storage Server 10.16.6.116 DS-NVR: 13-FC

3. Click Add to add the storage server.

You can add the storage server in the following ways:

® By detecting the online storage server, refer to Chapter 3.1.2 Adding Online Devices.
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® By specifying the storage server IP address, refer to Chapter 3.1.3 Adding Devices by IP or
Domain Name.
® By IP Server, refer to Chapter 3.1.5 Adding Devices by IP Server.
4. (Optional) Select the added server and click Modify to edit its information.

You can click Delete to delete it.

Formatting the HDDs

Purpose:

The HDDs of the storage server need to be formatted for the video file.

Steps:

1. Select the added storage server from the list and click Remote Configuration.

2. Click HDD tab to enter the HDD Formatting page.

3. Select the HDD from the list and click Format.
You can check the formatting process from the process bar and the status of the formatted HDD
changes from Unformatted to Normal Status.

Note: Formatting the HDDs is to pre-allocate the disk space for storage and the original data of the

formatted HDDs will not be deleted.

HDD settings

HDD No. Disk Driver Capacity(MB) Free Space(MB) Status Type

1 D 184323 147397 Unformatted  Local
2 E 190207 188088 Unformatted Local

3 P 51200 36302432 Unformatted  Local
4 z 3145597 286169 Unformatted Local

Format

Configuring Storage Schedule

Before you start:
The storage server needs to be added to the client software and the HDDs need to be formatted for
the video file storage.
Steps:
1. Add the camera to the storage server first.
(1) In the Storage Server Management page, select the added storage server and click Remote
Configuration.

(2) Click Camera tab to enter the following page.
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Storage Server Parameters x

[7 Status
Set camera parameters of the device
W General (e.g. IP camera addition and deletion)

[~} Camera
i Schedule © Add ¥ Delete

Q) Network

Reboot Default Save

(3) Click Add and select a camera from the group to add the camera to the storage server.
(4) (Optional) Select the added camera and click Delete to delete the camera from the storage
server.
(5) Click Save to save the settings.
2. Configure the recording schedule for the added cameras.

(1) In the Remote Configuration page, click Schedule tab to enter the following page.

Set recording schedule of the camera.

Camera: Camera01 v

Recording Schedule:  Template 02 {4 Copyto

(2) Select the added camera from the dropdown list.
(3) Select one recording schedule.
® All-day Template: for all-day continuous recording.
® Weekday Template: for working-hours continuous recording from 8:00 AM to 8:00 PM.
® Alarm Template: for the alarm triggered recording.
® Template 01 to 08: fixed templates for specific schedules. You can edit the templates if
needed.
® Customized: can be customized as desired.
If you need to edit or customize the template, refer to Configuring Recording
Schedule Template
After adding the camera to the storage server and setting the recording schedule, the recording
schedule on storage server function will be enabled.
Notes:
® To change the recording resolution, bit rate or other recording parameters, please refer to
Chapter 4.1 Picture Settings.
® To ensure that event recording works properly, please set motion detection and video
tampering area and arming schedule first. For details, refer to Chapter 4.5 Motion Detection and

Chapter 4.6 Tampering Alarm.
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4.4 Video Display

The Display menu allows you to configure the display settings for the camera, including:

® Display Name: the camera name displayed on the live video.
® Display Date: the date displayed on the live video.
® Display Week: Display the week on the live video.
® Enable Privacy Mask: Enable privacy mask function on the live video.
® Text Overlay: Edit user-defined text to be displayed on the live video.
Camera:  camera_Camera01 v
Set camera display parameters like OSD and privacy mask.
[V Display Name
Camera Name: [Camera 01
[V Display Date
Date Format: MM-DD-YYYY W
Time Format: 24-hour v
v Display Week
OSD Attribute: Transparentand Flash  ~
Copy 10 ...
[V Enable Privacy Mask
- Y4 Text Overlay:
= & 0O & =
Songs  somings  Sehede  pIFY
- E D E
Oooden  Aam®  low  Przcom
Device Settings Save
Steps:
1. Click Video Display to enter the video display settings page.
2. Check the checkboxes to display the name, date, or week to the video image.
3. Set the OSD Attribute.
4. (Optional) Click Copy to... and select other cameras to copy the video display settings to other
cameras.
5. Display privacy mask on the video image.

1) Check Enable Privacy Mask checkbox.
2) Select Draw Privacy Mask Area option from the drop-down list.

3) Drag your cursor to draw a rectangle as privacy mask.
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Draw Privacy Mask Area

You can click to remove the selected privacy mask area, or clickﬂ to clear all privacy
mask areas on the live video.
Note: Up to four privacy mask areas can be configured.
6. Set the text overlay.
1) Check the checkbox in the Text Overlay.
2) Input the text content.
7. Configure the OSD location and the privacy mask location & size on the video image.
1) Select Insert OSD/Camera Name/Text option from the drop-down list.

2) Move the OSD to the desired location on the video image.

2016-08-25 18:53:56 »

Insert OSD / Camera Name /Text ~

8. Click Save to save the settings.

4.5 Motion Detection

Purpose:
A motion detection alarm is triggered when the client software detects motion within its defined
area. The linkage actions, including alarm output, channel record and client action can be set.
Note: The configuration varies according to different devices. For details, please refer to the user
manual of the devices.
Steps:
1. Click Motion Detection to enter the motion detection alarm settings page.
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2. Check Enable Motion Detection checkbox.

Select the arming schedule template from the drop-down list.

® All-day Template: For all-day continuous arming.

® Weekday Template: For working-hours continuous arming from 8:00 AM to 8:00 PM.

® Template 01 to 09: Fixed templates for special schedules. You can edit the templates if

needed.

® Customized: Can be customized as desired.

If you need to edit or customize the template, see Configuring Arming Schedule

Template

4. Drag the mouse on the live video image to draw a defined area for the arming region.

You can click . to set the whole video area as detection area, or click u to clear all the

detection area.

5. Drag the slider on the sensitivity bar to adjust the motion detection sensitivity. The larger the

value is, the more sensitive the detection is.

6. Check the checkboxes to activate the linkage actions.

Linkage Actions

Descriptions

Audible Warning

The client software gives an audible warning when alarm is triggered. You can
select the alarm sound for audible warning. For setting the alarm sound,

please refer to Chapter 10.2.4 Alarm Sound Settings.

Email Linkage

Send an email notification of the alarm information to one or more receivers.

For setting the email parameters, refer to Chapter 10.2.5 Email Settings.

Notify Surveillance

Upload alarm information to the client software when motion detection is

Center triggered.
Full Screen ] ] ) ) )
L. Switch to full screen to monitor the motion detection video.
Monitoring
Upload Captured When motion alarm is triggered, pictures will be captured and uploaded to

Picture to FTP

FTP server.

Tigger Alarm Output

Enable the alarm output function. Select the alarm output port and the

external device connected to the port can be controlled.

Triggered Camera

Start the recording of the selected cameras when alarm is triggered.

7. Click Save to save the settings.
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Set motion detection parameters of the camera
(e.g., arming schedule, linkage actions, detected area, efc.).

[V Enable Motion Detection

Arming Schedule: All-day Template
Actions
[ Audio Waming [ Email Linkage

[V Notify Surveillance Center Full Screen Monitoring

[ Upload Picture To FTP
[ Trigger Alarm Output Triggered Camera
[ A1 [~ Camera01

[ A2

Save

Network
Connection

Device Settings

Configuring Arming Schedule Template

Perform the following steps to configure the arming schedule template:

If Template 01 to 09 is selected in the drop-down list, start from step 1;

If Custom is selected in the drop-down list, start from step 2.

Steps:

1.

4.

Click Edit to enter the Templates Management page. Select the template to be set and you can
edit the template name.

Set the time schedule for the selected template.

When the cursor turns to , you can set the time period.

When the cursor turns to -“’I, you can move the selected time bar you just edited. You can
also edit the displayed time point to set the accurate time period.

When the cursor turns to _, you can lengthen or shorten the selected time bar.
Optionally, you can select the schedule time bar,

and then click (X) to delete the selected time bar,

or click o to delete all the time bars,

or click I to copy the time bar settings to the other dates.
Click OK to save the settings.

Note: Up to 8 time periods can be set for each day in the arming schedule template.
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All-day Template OB o e
Waekday Temm Mon [ 2 4 6 8 10 12 14 16 18 20 22 24
Template 01
Tue o 2 - 6 8 10 12 14 16 18 20 22 24
[Terpate0z | ——
Wed 0 2 = 6 8 10 12 14 16 pt ] 20 22 24
onpiole 0> I ———
Template 04 Thu 0 2 4 6 8 10 12 14 16 18 20 2 24
Template 05
Fri 0 2 B 6 ] 10 12 4 16 18 20 2 24
0 r - ]
Sal 0 2 o 6 8 10 12 14 16 pt ] 20 2 24
[fempate0r |
Yemle 08 Sun 0 2 4 6 8 10 12 14 16 18 20 2 24
Tomplate 09 Holiday 0 2 4 6 8 10 12 14 16 18 20 2 24
Customized

Templates

¢
) |

(" ArdayTempiaste (@ W |5
(" Weekday Templ...

Mon 0 2 4 6 8 10 12 14 16 18 20 22 24
(" Template 01 T T T T

06:50-15:00

'a Te ate 02 Tue 0 2 4 6 ] 10 - -4 16 18 20 2 24
C TW“OG Wed o 4 4 6 8 10 12 14 16 18 20 2 24
(" Template 04

Thu o 2 4 6 ] 10 12 14 16 18 20 2 24
(" Tempiate 05 I ———
'a Template 06 Fri ] 2 4 6 8 10 12 14 16 18 20 22 24
C Twa'e°1 Sat o 2 4 6 8 10 12 14 16 18 20 2 24
(" Template 08 w

Sun 0 2 4 6 8 10 12 14 16 18 20 2 24
(" Template 09 s
(e Customized

OK Cancel

4.6 Tampering Alarm

Purpose:
A video tampering alarm is triggered when the camera is covered and the monitoring area cannot be
viewed. The linkage actions, including alarm output and client action can be set.
Steps:
1. Click Tampering Alarm to enter the tempering alarm settings page.
2. Check Enable Tampering Alarm checkbox.
3. Select the arming schedule template from the drop-down list.
® All-day Template: For all-day continuous arming.
® Weekday Template: For working-hours continuous arming from 8:00 AM to 8:00 PM.
® Template 01 to 09: Fixed templates for special schedules. You can edit the templates if
needed.
® Customized: Can be customized as desired.
If you need to edit or customize the template, see Configuring Arming Schedule
Template
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4. Drag the mouse on the live video image to draw a defined area for the arming region.

You can click & to set the whole video area as detection area, or click O to clear all the

detection area.

5. Drag the slider on the sensitivity bar to adjust the tampering alarm sensitivity. The larger the

value is, the more sensitive the detection is.

6. Check the checkboxes to activate the linkage actions.

Linkage Actions

Descriptions

Audible Warning

The client software gives an audible warning when alarm is triggered. You can
select the alarm sound for audible warning. For setting the alarm sound,

please refer to Chapter 10.2.4 Alarm Sound Settings.

Email Linkage

Send an email notification of the alarm information to one or more receivers.

For setting the email parameters, refer to Chapter 10.2.5 Email Settings.

Notify Surveillance

Upload alarm information to the client software when motion detection is

Center triggered.
Full Screen ] ] ) ) )
L. Switch to full screen to monitor the motion detection video.
Monitoring
. Enable the alarm output function. Select the alarm output port and the
Tigger Alarm Output

external device connected to the port can be controlled.

7. Click Save to save the settings.

Camera:  camera_Camera01

Sensitivity(1)

o= | o |
=, e

Pictur Video Video
s-m\'g'k Settings Schedule Display
al= = L
dm MR moes
- Save
Network

Connection

Device Settings

Set tempering alarm parameters of the camera
(e.g., arming schedule, linkage actions, detected area, etc.).

[V Enable Tampering Alam
Arming Schedule: Allday Template £
Actions
Audio Warning v Email Linkage
[ Notify Surveitlance Center Full Screen Monitoring

[ Trigger Alarm Output

4.7 Video Loss

Purpose:

When the client software cannot receive video signal from the front-end devices, the video loss

alarm will be triggered. The linkage actions, including alarm output and client action can be set.

Steps:

1. Click Video Loss to enter the video loss alarm settings page.
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Set video loss parameters of the camera

(e.g., arming schedule, linkage actions , etc.)

[V Enable Video Loss Detection
Arming Schedule:

Actions

Save

2. Check Enable Video Loss Detection checkbox.

Click the arming schedule and select the arming schedule template.

® All-day Template: For all-day continuous arming.

® Weekday Template: For working-hours continuous arming from 8:00 AM to 8:00 PM.

® Template 01 to 09: Fixed templates for special schedules. You can edit the templates if

needed.

® Customized: Can be customized as desired.

If you need to edit or customize the template, see Configuring Arming Schedule

Template

4. Check the checkboxes to activate the linkage actions.

Linkage Actions

Descriptions

Audible Warning

The client software gives an audible warning when alarm is triggered. You can
select the alarm sound for audible warning. For setting the alarm sound,

please refer to Chapter 10.2.4 Alarm Sound Settings.

Email Linkage

Send an email notification of the alarm information to one or more receivers.

For setting the email parameters, refer to Chapter 10.2.5 Email Settings.

Notify Surveillance

Upload alarm information to the client software when motion detection is

Center triggered.
Full Screen ] ) ) ) ]
L Switch to full screen to monitor the motion detection video.
Monitoring
. Enable the alarm output function. Select the alarm output port and the
Tigger Alarm Output

external device connected to the port can be controlled.

5. Click Save to save the settings.
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4.8 PTZ Control

Purpose:
In the PTZ Control configuration page, you can specific the PTZ connection parameters, such as baud

rate, data bits, stop bits, parity, and so on.

Steps:
1. Click PTZ Control to enter the PTZ control configuration page.
Set PTZ parameters (e.g., baud rate, protocol, address, etc.)
Baud Rate: 9600 v
Data Bit: 8 v
Stop Bit: 1 v
Parity: None v
Flow Control: None v
Protocol Type: PELCO-D v
PTZ Address: [0 Test
Copy to ... Save

2. Setthe PTZ parameters, such as baud rate, data bits, stop bits, parity, flow control, PTZ protocol,
and PTZ address.
Note: All these PTZ parameters should be consistent with the local settings on the PTZ to ensure
valid PTZ control.
(Optional) Click Copy to... to copy all the PTZ settings to other cameras.

Click Save to save the settings.

4.9 Network Connection

In the Network Connection configuration page, you can specify the protocol and select the stream

type of the camera. You can also configure stream media server.

4.9.1 Network Parameter Settings

Steps:

1. Click Network Connection to enter the Network Connection configuration page.

Set connection parameters of the camera

(e.g., network protocol, stream type, stream media server, etc.).

Protocol Type: TCP v

Stream Type: Main Stream v

[ GetVideo Stream via Stream Media Server

Stream Media Server: Stream Media Server

Copy to ... Save

2. Set the protocol as TCP, UDP, MCAST, or RTP.

3. Select Main Stream or Sub-Stream as the stream type of the camera.
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Note: The stream type settings will take effect after start live view again. You can also set the
stream type in Main View module. For details, refer to Chapter 5 Live View.

4. Check Get Video Stream via Stream Media Server checkbox to enable the stream media server.
Note: You should add the stream media server first. For details, refer to Chapter 4.9.1 Network
Parameter Settings.

Select the stream media server.
(Optional) Click Copy to... to copy all the network connection settings to other cameras.

Click Save to save the settings.

4.9.2 Stream Media Server Management

Purpose:
There is always a limit of the device remote access number. When there are many users wanting to
get remote access to the device to get the live view, you can add the stream media server and get

the video data stream from the stream media server, thus to lower the load of the device.

Adding the Stream Media Server

Before you start:
The stream media server application software needs to be installed on other PC running Windows OS.
When installing the Guarding Vision, check Stream Media Server checkbox to enable the installation
of stream media server.
Steps:
1. Click L on the desktop to run the stream media server.
Notes:
® The Stream Media Server can only be installed on the PC running Windows OS.
® If the stream media server port (value: 554) is occupied by other service, a window will
open. You should change the port No. to other value to ensure the proper running of the
stream media server.
2. On the Guarding Vision Client, click ’ to open the Stream Media Server Management page.
Or you can click Stream Media Server on Network Connection page of Camera Settings to enter

the Stream Media Server Management page.
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Stream Media Server Management x

@ Add [# Modify T Delete J7 Remote Configuration Searct

Nickname P

10.16.6.116 10.16.6.116

3. Click Add to open the following page.

Add Stream Media Server x

Nickname: [

IP: [

Port: [ 554

Add Cancel

4. Input the required information, including nickname, IP address, and port.
Note: The default port value is 554.
5. Click Add to add the stream media server to the client software.
Note: For one client, up to 16 stream media servers can be added.
After adding the stream media server, you can perform the following operations.
® Select the stream media server and click Modify to edit its information.

® Select the stream server and click Delete to delete it.

Adding Cameras to Stream Media Server to Forward Video Stream

Purpose:

To get the video stream of a camera via stream media server, you need to connect the camera to the

stream media server.

Steps:

1. Select the stream media server from the list.

2. Click Remote Configuration to enter the Stream Media Server Settings page.

3. Click Channel Configuration tab.

4. Select the camera group and select cameras of which the video stream is to be forwarded via
the stream media server.

5. Click OK to save the new settings.
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6. Go the Main View page and start the live view of the cameras again. You can check the channel
number of the video stream forwarded through or sent from the stream media server.

Notes:

® For one stream media server, up to 64 channels of video stream can be forwarded through it
and up to 200 channels of video stream can be sent to clients from it.

® [f the camera is offline, the client can still get the live video via the stream media server.

Stream Media Server Settings b

Port Configuration Channel Configuration
Group: 10.33.3.159 v
Camera:
Al
[T 10.33.3.159_Camera01
10.33.3.159_Camera02
10.33.3.159_Camera03
10.33.3.159_Camera04
(o0 Cancel
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Chapter S Live View

Purpose:

For the surveillance task, you can view the live video of the added network cameras, video encoders

and video intercom device on the Main View page. And some basic operations are supported,

including picture capturing, manual recording, PTZ control, etc.

Before you start:

A camera group is required to be defined for live view.

Click LY on the control panel, or click View->Main View to open the Main View page.

[ test01
B Al File(s)
= Picture
() camera
@ camera_Camera01

B Al Fie(s)
=) Picture

Main View Page

1 Camera List

2 Display Window of Live View

3 Live View Toolbar

Camera Status:

The camera is online and works properly.

The camera is in live view.

The camera is in recording status.

&S

The camera is offline.

Live View Toolbar:

On the Main View page, the following toolbar buttons are available:

. Full Screen Display the live view in full screen mode. Press ESC to exit.
QE,/ Window Division | Set the window division.
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E D Start/Stop Start or stop the live view of all cameras.
:’Z Capture Capture the current image of the camera.
. Start manual recording for the corresponding cameras, click again to
. Start Recording
stop.

Previous Go for live view of the previous page.
:} Next Go for live view of the next page.

Start/Stop ) o
. Click to resume/pause the auto-switch in live view.

Auto-switch

Show/Hide Menu

Show/Hide the configuration menu of auto-switch. Click again to hide.

&

Volume

Turn off/on the audio in live view and you can adjust the volume.

Right-click on the display window in live view to open the Live View Management Menu:

@ Capture
© Start Recording

4 PTZ Control

@ Digital Zoom

= Camera Status
¢ Camera Settings
L Synchronization
& Audio on

Q Stop Live View
@, Fisheye Expansion
@ Switch to Instant Playback

28 Full Screen

The following buttons are available on the right-click Live View Management Menu:

Capture

Capture the picture in the live view process.

Start/Stop Recording | Start/Stop the manual recording. The video file is stored in the PC.

A

PTZ Control

Enable PTZ control function on the display window.

@

Digital Zoom

Enable the digital zoom function. Click again to disable the

function.

Camera Status

Display the status of the camera in live view, including the

recording status, signal status, connection number, etc.

Open the Camera Settings page of the camera. Refer to Chapter 4

g Camera Settings )
Camera Settings.
- Sync the camera in live view with the PC running the client
+ Synchronization
- software.
@ ) | Audio On/Mute Click to enable/disable the audio in live view.
Y Stop Live View Stop the live view in the display window.
. . Enter the fisheye expansion mode. Only available when the device
</ Fisheye Expansion o
is fisheye camera.
Switch to Instant )
@ Switch to Instant playback mode.
Playback
28 Full Screen Display the live view in full screen mode. Press ESC to exit.
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5.1 Starting and Stopping the Live View

Starting Live View for One Camera

Steps:
1. Open the Main View page.
2. (Optional) Click in live view toolbar to select the window division mode for live view.
3. Drag the camera to the display window,
or double-click the camera name after selecting the display window to start the live view.
Note: You can drag the video of the camera in live view to another display window if needed.
4. (Optional) In the device list on the left, you can right-click on the camera group name, or on the

camera name to open the right-click menu.

= (Camera Status
¢: Camera Settings

- o Expand All

(45 I n

+ Synchronizatio Fold All

v Main Stream [~ Set Main Stream To Al
Sub-Stream [v Set Sub-Stream To All

For camera group, you can check to expand or fold all the cameras display in the group. And you
can also switch the stream between main stream and sub stream for all the cameras in the
group.

For camera, you can click to view the camera status, to enter the camera settings page to
configure the camera, and sync the camera time with the PC. And you can also switch the
stream between main stream and sub stream.

Note: The stream settings will take effect after starting live view again.

Starting Live View for Camera Group

Steps:
1. Open the Main View page.
2. Dragthe group to the display window,
or double-click the group name to start the live view.

Note: The display window number is self-adaptive to the camera number of the group.

Stopping the Live View

Steps:
1. Select the display window.
2. Click Stop Live View on the right-click menu to stop the live view of the display window.

You can also click n in live view toolbar to stop all the live view.

5.2 Auto-switch in Live View

Purpose:

The video stream of the cameras from the same group will switch automatically in a selected display
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window in camera auto-switch.

Steps:

1. Open the Main View page.

2. Select a display window for camera auto-switch.

3. Click H in the toolbar and select the auto-switch in single screen or multiple screens.
Set the dwell time for the auto-switch.

@ single-Screen Auto-Switch

© Muiti-Screen Auto-Switch

Dwell Time
20s 1min. 3min. 5min.

Cannot config when previewing.

4. Select a group, and select the window for auto switch.
5. Click on the toolbar to start the camera auto-switch.

6. Click :: or :} to view the live video of previous or next camera.

5.3 PTZ Control in Live View

The software provides PTZ control for cameras with pan/tilt/zoom functionality. You can set the
preset, patrol and pattern for the cameras on the PTZ Control panel. And you can also open window
PTZ control for the operations of PTZ cameras.

Note: The PTZ Control function should be supported by the device.

Right-click on the live view window, and click PTZ Control to open the PTZ Control panel.

vy a 4 + O -
« U » + a4 -
» v a4 + O -
- ——— %
r
Preset Pattern Patrol
v ;’1 9

Index Name I;
01 Preset1

02 Preset2

03 Preset3

04 Preset4 v

The following buttons are available on the PTZ Control panel:

Q Zoom

| Focus

O Iris

[ 3D Positioning
4 Light

2\ 2 Wiper
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vy A ¥

« U »

b VYV 4

Directional buttons, click 0 to start/stop auto-scan.

= w—— * | Speed adjustment for PTZ function

5.3.1 Configuring the Preset

Purpose:

A preset is a predefined image position which contains information of pan, tilt, focus and other
parameters.

Steps:

1. Click Preset tab to enter the PTZ preset configuration panel.

2. Click the direction buttons and other buttons on the PTZ control panel to steer the camera to

the desired view.

-
3. Select a PTZ preset number from the preset list and click # .

Name:

OK Cancel

4. Input the name of the preset in the pop-up window.
5. Click OK to save the settings.

To call a configured preset, double-click the preset, or select the preset and click .

You also perform the following steps to call the preset.

Steps:

1.  Click to select a live view window.

2. Forpreset1to9, click the corresponding number key (e.g., 4) to call the preset.
For other presets, click “[”, number keys (e.g., 124), and “]” to call the preset.

To modify a configured preset, select the preset from the list and click »ﬂ.

To delete a configured preset, select the preset from the list and click \>.

5.3.2 Configuring the Pattern

Purpose:

A pattern is a memorized, repeating series of pan, tilt, zoom, and preset functions.
Steps:

1. Click Pattern tab to enter the PTZ pattern configuration panel.
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Preset Pattern Patrol

w U -

N
Click #° to start recording of this pattern path.
Use the direction buttons to control the PTZ movement.

Click ¥ to stop and save the pattern recording.

vk W

Click @ to call the pattern.
To stop calling the pattern, click .

5.3.3 Configuring the Patrol

Purpose:

A patrol is a scanning track specified by a group of user-defined presets, with the scanning speed
between two presets and the dwell time at the preset separately programmable.

Before you start:

Two or more presets for one PTZ camera need to be added.

Steps:

1. Click Patrol tab to enter the PTZ patrol configuration panel.

Preset Pattern Patrol

Path 1 v O Q¢
T71 Preset1  1s 1
[+

2. Select a path number from the drop-down list.

3. Click + to add a preset, and set the dwell time and patrol speed for the preset.

Add Patrol No. x

Preset: 1 hd
Dwell Time(s): 1

Patrol Speed: 1

OK Cancel

4. Repeat the above operation to add other presets to the patrol.
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5. Optionally, you can click % or g to edit or delete a preset in the patrol path.
6. Click %@ to call the patrol.
To stop calling the patrol, click .
Note: The preset dwell time can be set to 1 to 30 sec, and the patrol speed can be set to level 1 to

40.

5.4 Local Recording and Capture

5.4.1 Manual Recording in Live View

Purpose:
Manual Recording function allows you to record the live video on the Main View page manually and
the video files are stored in the local PC.
Steps:
1. Select the live view window, and click - on the toolbar,
or right-click on the live view window and select Start Recording to start the manual recording.
The icon v on the right-click menu turns to 'e.
2. Click the . button on the toolbar again,
or click Stop Recording on the right-click menu to stop the manual recording.
A prompt with the saving path of the video files you just recorded will open if all the operations
succeed.
Note: The saving path of video files can be set on the System Configuration page. For details, refer to
Chapter 10.2.3 File Saving Path Settings.

5.4.2 Viewing Local Video Files

Steps:
1. Inthe Main View page, click All Files(s) under the device to view all the recorded video files of

the device.
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Q
Camera: All Cameras v
[ 10.33.3.159 = -
Start Time: 2016-08-25 00:00:00 End Time: 2016-08-25 23:59:59 Search
@ 10.33.3.159_Camera01
& 10.33.3.159_Camera02
& 10.33.3.159_Camera03
& 10.33.3.159_Camerad4
(=, Picture
£ 10.16.6.126 -~
@& 10.16.6.126_Camera01
B ArFie(s)

| Picture 1

2. Select the camera to be searched from the Camera list.

3. Click B2 to specify the start time and end time for search.
Click Search.

The video files recorded locally between the start time and end time will display.

The following buttons are available at the bottom of the page for each video file.

- % W

® Select the video file, and click Delete. You can delete the video file.

® Select the video file, and click Email Linkage. You can send an Email notification with the
selected video file attached.
Note: To send an Email notification, you should set the Email settings before proceeding. For
details, refer to Chapter 10.2.5 Email Settings.

® Select the video file, and click Save as. You can save a new copy of the video file.

Double-click the video file and the video file can be played locally.

06-21-2016 M= 19:45:09

il

o i Gl i i i

00:00:46/00:01:38

The following buttons are available on the local playback page:

‘ E 8 ‘ CIF/4CIF ’ Display the video in cif/4cif resolution.
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n Close Close the local playback page of the video files.

n n Pause/Play Pause/Start the playback of the video files.

u Stop Stop the playback of the video files.

n n Speed Down/Up Set the playback speed.

n Single Frame Play back the video files frame by frame.

ﬂ Digital Zoom Enable the digital zoom function. Click again to disable.
n Audio On/Mute Click to enable/disable the audio in the local playback.
Capture Capture the picture in the playback process.

5.4.3 Capturing Picture in Live View

Select the live view window, and click in the toolbar, or right-click on the live view window and
select Capture to capture the current image of the live view window.

A small window of the captured picture will display to notify whether the capturing operation is

done or not.

Note: The saving path of the captured pictures can be set on the System Configuration page. For
details, refer to Chapter 10.2.3 File Saving Path Settings.

5.4.4 Viewing Captured Pictures

Purpose:
The pictures captured in live view are stored in the PC running the software. You can view the

captured pictures if needed.

Steps:
1. Inthe Main View page, click Picture under the device to view all the captured pictures of the
device.
Q
Camera: All Cameras
1 10.33.3.189
Start Time: 2016-08-25 00:00:00 = End Time: 2016-08-25 23:59:59 = Search

@& 10.33,3.159_Camera01
@ 10.33,3.159_Camera02
@ 10.33,3.159_Camera03
@ 10.33,3.159_Camera04
B ArFie(s)

[Z1 10.16.6.126 ~

@& 10.16.6.126_Camera01
B AnFile(s)

(=) Picture b |

2. Select the camera to be searched from the Camera list.

3. Click to specify the start time and end time for the search.
4. Click Search.

The pictures captured between the start time and end time will be displayed.
5. Double-click the captured picture to enlarge it for a better view.
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The following three buttons are available at the bottom of the page for each picture.

® Select the captured picture, and click Delete. You can delete the selected picture.
®  Select the captured picture, and click Email Linkage. You can send an Email notification with the
selected picture attached.

® Select the captured picture, and click Save as. You can save a new copy of the selected picture.

5.5 Instant Playback

Purpose:
The video files can be played instantly on the Main View page. Instant playback shows a piece of the
video which was remarkable, or which was unclear on the first sight. Thus, you can get an immediate
review if needed.
Note: You can set the pre-play time for instant playback in System Configuration. By default, it is 3
minutes. For configuring the pre-play time, refer to Chapter 10.2.1 General Settings.
Before you start:
The video files need to be recorded on the storage devices, such as the SD/SDHC cards and HDDs on
the DVRs, NVRs, Network Cameras, etc., or on the storage servers.
Steps:
1. Start the live view.
2. Right-click on the window to show the Live View Management menu.
3. Click Switch to Instant Playback to switch to instant playback mode.

A simple timeline will appear near the live view toolbar. Move the mouse to the simple timeline

and a complete timeline will appear as follows:

<

2011-03-1p 08:37:39
Y &= e

4. Drag the timeline at the bottom to adjust the playback progress. You can also click or =
to scale up or down the time bar to choose a more accurate playback time.
5. Right-click on the playback window and click Live View to stop the instant playback and go back

for the live view.

During instant playback, right-click on the display window to open the Instant Playback Management

Menu:

[> Play
O Stop
¢> Fast Forward
X Slow
(> Single Frame

rward

Add Default Tag
[z= Add Customized Tag
& Tag Download
k2 Capture
© Start Recording
«® Audioon

@ Switch to Live View

The following buttons are available on the right-click Instant Playback Management Menu:
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» Pause/Resume Pause/start the instant playback in the display window.
= Stop Stop the instant playback and return to the live view mode.
Fast Forward/Slow )
-« Increase/decrease the play speed of the instant playback.
Forward
i» Single Frame Play back the video file frame by frame.
[+ Add Default Tag Add a default tag to the current timeline of the video file.
Add a custom tag to the current timeline of the video file and you
R Add Custom Tag

can set the tag name.

Tag Download

Download the files by added tags.

Capture

Capture the picture in the instant playback process.

80 &«

Start/Stop Recording

Start/Stop clipping the video files.

2 =)

Audio on/Mute

Click to turn on/off the audio in instant playback.

®

Switch to Live View

Switch to live view mode.

5.6

Purpose:

Custom Window Division

The client software provides multiple kinds of pre-defined window division. You can also set custom

window division as desired.

Steps:

1. Click on the live view toolbar and select Edit to open Edit Custom Window Division

window.

Add

Edit Custom Window Division X

Name: ——

2.  Click Add to open Add Custom Window Division window.

Note: Up to 5 custom window divisions can be added.

Set a name for the new window division as desired.

Click OK to save the settings.

Drag your mouse to select the adjacent windows, and click Joint to joint them as a whole

window. You can also click Cancel to cancel the jointing.

Click Save to confirm the settings.
Click B to back to the Main View page.

Then you can click and select the custom window division for playing live video.
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Notes:

5.7

Purpose:

You can also enter the Remote Playback page and perform the steps above to configure
the custom window division.
For remote playback, up to 16 windows can be played at the same time. The custom

window division with more than 16 windows is invalid for playback.

Live View in Fisheye Mode

You can play the live video of the camera in fisheye expansion mode.

Note: The Fisheye Expansion is suitable for the fisheye camera. If you enable Fisheye Expansion for

other cameras, the image may be distorted.

Steps:

1. Start the live view (refer to Chapter 5.1 Starting and Stopping the Live View).

Right-click on the video and select Fisheye Expansion to enter the Fisheye Expansion window.

2
3. Select the mounting type of the fisheye camera according to the actual mounting position.
4

You can select the expanding mode for live view as desired.

Note: For some devices, you can select the mounting type of the device and the related

expanding mode will be listed.

Fisheye Expansion

Mounting Type

Sxpanding Mode A

i 4 Q

PTZ Control ~ 9

Preset Patrol

Preset 1

@ Preset 1
B Preset2
@ Preset7

@ Preset9

Fisheye: In the Fisheye view mode, the whole wide-angle view of the camera is displayed.
This view mode is called Fisheye because it approximates the vision of a fish’s convex eye.
The lens produces curvilinear images of a large area, while distorting the perspective and
angles of objects in the image.

Panorama/Dual-180° Panorama/360° Panorama: In the Panorama view mode, the
distorted fisheye image is transformed to normal perspective image by some calibration
methods.

PTZ: The PTZ view is the close-up view of some defined area in the Fisheye view or
Panorama view, and it supports the electronic PTZ function, which is also called e-PTZ.
Notes:
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® Each PTZ view is marked on the Fisheye view and Panorama view with a specific
navigation. You can drag the navigation on the Fisheye view or Panorama view to
adjust the PTZ view, or drag the PTZ view to adjust the view to the desired angle.

® The navigation will be hidden after 5 seconds of inactivity.

PTZ Control

In PTZ mode, you can use the PTZ control to adjust the PTZ window.

Note: The PTZ panel varies according to different devices.

®  Select a PTZ window, and click one of the direction buttons to adjust the view angle.
Note: Click-and-drag the No. label in the fisheye or panorama window will change the view
angle of the PTZ window as well.

Select a PTZ window, and click O tostart auto-scan, and click it again to stop auto-scan.

= = +: Drag the slider to adjust the speed for PTZ movement.

° * 1@ 7 . Zoom in or zoom out the selected PTZ window by clicking |+ or [=. Oryou can

scroll the mouse wheel to zoom in or zoom out.
Preset
Note: The preset is only supported by specific fisheye camera.
Purpose:
A preset is a user-defined monitor position/point. You can simply call the preset No. to change the
monitor scene to the defined position.
Steps:
Click Preset tab to enter the preset configuration page.
Select a PTZ window, and adjust the scene to the place you want to mark as a preset.

1
2
3. Click ‘7, input the preset name, and click OK to save a preset.
4. (Optional) Click 4 to call the configured preset.

5

(Optional) Click 9 to delete the configured preset.
Note: Up to 256 presets can be configured.
Patrol
Note: The patrol is only supported by specific fisheye camera.

Purpose:
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A patrol is a scanning track specified by a group of user-defined presets, with the scanning speed
between two presets and the dwell time at the preset separately programmable.
Before you start:
At least 2 presets have to be configured before you configure the patrol.
Steps:
1. Click Patrol tab to enter the patrol configuration page.
2. Select a patrol No. from the drop-down list.
3. Click to add the configured presets, and set the dwell time and patrol speed for the preset.
Notes:
® The dwell time ranges from 1 to 30s.
® The patrol speed ranges from 1 to 40.

Add Patrol No. X

Preset: 1 v
Dwell Time(s): 1

Patrol Speed: 1

OK Cancel

4. Repeat the above operation to add other presets to the patrol.

5. Click K@ to start the patrol, and click & to stop patrol.

> =
6. Optionally, you can click #° or to edit or delete a preset in the patrol path.
Note: Up to 32 patrols can be set.

5.8 Other Functions in Live View

There are some other functions supported in the live view, including digital zoom, camera status and

synchronization.

Digital Zoom

Use the left key of mouse to drag a rectangle area in the lower-right/upper-left direction, and then
the rectangle area will zoom in/out. You can also use the mouse wheel for zooming in or restoring of

the video in digital zoom mode.

Camera Status

The camera status, such as recording status, signal status, connection number, etc., can be detected

and displayed for check. The status information refreshes every 10 seconds.

Synchronization

The synchronization function provides a way to synchronize the device clock with the PC which runs

the client software.
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Chapter 6 Remote Playback

Purpose:

The video files stored on the local device or the storage server can be searched by camera or
triggering event, and then can be played remotely.

Before you start:

You should set the recording schedule first so that the videos will be recorded and can be played. For
setting the recording schedule, refer to Chapter 4.3 Schedule.

6.1 Normal Playback

Purpose:
The video files can be searched by camera or group name for the Normal Playback.

Click © on the control panel, or click View->Remote Playback to open the Remote Playback page.

Remote Playback Page
1 Camera List
2 Search Condition
3 Calendars
4 Display Window of Playback
5 Playback Control Buttons
6

Timeline

6.1.1 Searching Video Files

Steps:
1. Openthe Remote Playback page.

2. Inthe camera list, check to select the cameras for playback.
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Note: Up to 16 cameras can be searched simultaneously.

3. Inthe File Type dropdown list, you can select the file type to narrow down the search scope and
search for only the video files for certain types.

4. Inthe calendar panel, select the date you want to search.
Note: If there are video files for that camera in that day, the date which has video files will be
marked with .

5. Click Search to search the video files and the playback will start.
Or you can select the date in the calendar panel and drag the camera to the display window to

play the video files of the single camera.

6.1.2 Playing Video Files

After searching the video files for the normal playback, the playback will start in the display window.

The timeline indicates the time duration for the video file.

Click on the timeline to play back the video of the specific time.

You can click ** or ** to scale up or scale down the timeline bar.

>

You can click t€! or 21 on the timeline bar to go to the previous or the next time period.

You can use the mouse wheel to zoom in or zoom out on the timeline.

Normal Playback Toolbar:

"'«»"Q\;"::‘e

On the Normal Playback page, the following toolbar buttons are available:

Pause/start the playback of the video files of the selected
m u Pause/Play
camera.
E Stop Stop the playback of the selected camera.
Slow Forward/Fast
n Decrease/Increase the play speed of the playback.
Forward
. Play back the video files frame by frame. You can also scroll
n Single Frame . i
down the mouse wheel to play the video file frame by frame.
st Window Division | Set the window division.
E Stop All Stop playback of all cameras.
e Display the video playback in full-screen mode. Press ESC to
L d Full Screen )
exit.
n Volume Click to turn on/off the audio and adjust the audio volume.

Right-click on the display window in playback to open the Playback Management Menu:

55



User Manual of Guarding Vision

(> Single Frame

Digital Zoom

Tag Control »
VCA Search

il

Capture

Start Recording
Download
Audio on

L

2, Fisheye Expansion

28 Full Screen

The following items are available on the right-click Playback Management Menu:

> Play Start the playback.

14 Pause Pause the playback.

= Stop Stop the playback.

<~ Slow Forward Play the video file at a slower speed.

> Fast Forward Play the video file at a faster speed.

a Digital Zoom Enable the digital zoom function. Click again to disable the
function.
You can add tag for the video file to mark the important video
point.
Add Default Tag: Add tag and the default tag name is TAG.

i Tag Control Add Custom Tag: Add the tag and you can customize the tag

name.
Edit Tag: You can view all the added tags, edit the tag name as
desired, delete the added tag, and play back the video from the
tag.

Search the VCA event during playback. For details, refer to

= VCA Search
Chapter 6.5 VCA Playback

E Capture Capture the picture in the playback process.

oe Start/Stop Recording Start/Stop the manual recording. The video file is stored in the PC.

Download the video files of the camera and the video files are
4 Download i i
stored in the PC. You can select to download by file or by date.

k21) | Enable/Disable Audio Click to enable/disable the audio in playback.

Enter the fisheye playback mode. For details, please refer to

& Fisheye Expansion
v P Chapter 6.6 Fisheye Playback.

28 Full Screen Display the playback in full-screen mode. Press Esc key to exit.

6.1.3 Downloading Video Files

During playback, you can click Download on the right-click menu to download the video files of the

camera to the local PC. You can select to download by file, by date, or by tag.
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Download by Files

Steps:

1.

Click Download by Files tab in the File Download page. You can view the video files information
of selected camera.

Check the checkbox of the video file and the total size of the selected files will be shown below.
Click Download to start downloading the file to the local PC.

You can input the flow (0 to 32768 kbps) and click Set to control the downloading speed.

Optionally, you can click Stop to stop downloading manually.

File Download( Window01:10.16.5.106 10.16.5.106_|P Camera01) x

Download By Files Download By Date Download By Tag
[ Index Start Time End Time Size Status
1 2016-08-26 10:41:20 2016-08-26 11:05:43 523.7 MB Waiting
T2 2016-08-26 11:05:43 2016-08-26 11:41:20 1,016.0 MB Waiting
3 2016-08-26 11:41:20 2016-08-26 11:53:18 344.7 MB Waiting

[« I

All selected files size:

Free Disk Space Size:

Flow Ctrl(kbps): | Set Download Stop Cancel

Download by Date

Steps:
1. Click Download by Date tab in the File Download page.
2. Check the checkbox of the time duration to enable it, and click = to set the start and end time.
3. Click Download to start downloading the file to the local PC. The progress bar shows the
downloading process.
You can input the flow (0 to 32768 kbps) and click Set to control the downloading speed.
4. Optionally, you can click Stop to stop downloading manually.
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File Download( Window01:10.16.5.106 10.16.5.106_IP Camera01) X

Download By Files Download By Date Download By Tag
Start Time End Time
[v' Duration 1 2016-08-26 00:00:00 T 2016-08-26 23:59:59 B c—
F~7 Duration 2 2016-08-26 00:00:00 T 2016-08-26 23:59:59 [ ——
[ Duration 3 2016-08-26 00:00:00 | 2016-08-26 23:59:59 @ c—
[ Duration 4 2016-08-26 00:00:00 | 2016-08-26 23:59:59 g ———

All selected files size: 5.59 GB

Free Disk Space Size: 86.20 GB

Flow Ctrl(kbps): Set Download Stop, Cancel

Download by Tag

Steps:

1. Click Download by Tag tab in the File Download page. The added tags will be displayed.

2. Check the checkbox of the tag and the total size of the selected files will be shown below.

3. Click Download to start downloading the selected file (30 seconds before the selected tag to 30
seconds after the tag) to the local PC. You can input the flow (0 to 32768 kbps) and click Set to
control the downloading speed.

4. Optionally, you can click Stop to stop downloading manually.

File Download( Window01:10.16.5.106 10.16.5.106_IP Camera01) X

Download By Files Download By Date Download By Tag
[V Index Tag Name Time Size Status
V1 TAG 2016-08-26 10:48:39 222MB Waiting
V2 TAG 2016-08-26 10:48:45 222mB Waiting
V3 TAG 2016-08-26 10:48:53 222mB Waiting

All selected files size: 1.91 GB

Free Disk Space Size: 86.20 GB

Flow Ctrl(kbps): Set Download Stop, Cancel

6.2 Event Playback

Purpose:

The recordings triggered by event, such as motion detection and alarm input, can be searched for

58



User Manual of Guarding Vision

Event Playback and this function requires the support of the connected device.

Notes:

® Event playback function is only available for NVR/DVR which support event recording.

® Please import all the cameras to the group in Group Management page before search.

® |t is also required to enable continuous recording on all the alarm/motion-triggered channels

before event playback.

. =r
Click ™= on the control panel,

or click View -> Event Search to enter the Event Search page.

Window01:10.16.5.106 10.16.5.106_IP Car

(e Motion Detection ( Alarm Input

Group: 10.16.5.106 v

Camera: 10.16.5.106_IP Camer; +

Start Time: 2016-08-23 00:00:00 =

End Time: 2016-08-23 23:59:69 =
Q. Search

Search Results

Timo Ty E

2016-08-23 10:06:24  Motion Detection
2016-08-23 10:10:27 Motion Detection
2016-08-23 10:40:20 Motion Detection
2016-08-23 10:40:53 Motion Detection
2016-08-23 10:41:18 Motion Detection
2016-08-23 10:56:26 Motion Detection
2016-08-23 11:08:59 Motion Detection
2016-08-23 11:25:02 Motion Detection
2016-08-23 11:34:58 Motion Detection
2016-08-23 11:45:51 Motion Detection

2016-08-23 12:02:16 Motion Detection

2016-08-23 12:04:04 Motion Detection

2018-0&2? 12:00:00

Steps:
1. Select an event type: Motion Detection or Alarm Input.
2. Select a camera group and select the camera or alarm input in the group to search.
3. Click = to set the start time and end time for the search.
4. Click Search to start search.
All the video files that matching the search conditions will display in the Search Results panel.
5. Click to select a display window and then double-click the video file in the Search Result panel to
start playing the file.
A simple timeline will appear near the playback toolbar. Move the mouse to the simple timeline
and a complete timeline will appear as follows:
2011-03-1p 08:37:39
6. Drag the timeline at the bottom to adjust the playback progress. You can also click = or

to scale up or scale down the timeline bar to choose a more accurate playback time.

The following icons are available on the playback toolbar in the Event Search page.

Play Start playing the video file.

Ek2

Pause Pause playing the video file.
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@)

Stop

Stop playing all the video files.

B

Single Frame Play

Play the video file frame by frame.

— Playback Speed Change playback speed
Turn off/on the audio in live view and you can adjust the
n Volume

volume.

During playback, you can right-click to get the Event Playback Management menu as below.

& Capture

© Start Recording
4} Download

& Audioon

& Select Camera

Capture

Capture the picture in the playback process.

o0

Start/Stop Recording

Start/Stop the manual recording. The video file is stored in the PC.

¥

Download

Download the video files of the camera and the video files are

stored in the PC. You can select to download by file or by date.

)

Audio On/Mute

Clic

k to enable/disable the audio in playback.

&

Select Camera

Select a recording-triggered channel for playback

6.3

Purpose:

Search the video files for ATM DVR.

Note: This function should be supported by the device and the device should be configured with

ATM Playback

transaction rules. For details, please refer to the user manual of the device.

Click © on the control panel, or click View->Remote Playback to open the Remote Playback page.

6.3.1 Searching Video Files for ATM Playback

Steps:

1. Open the Remote Playback page.
2. Select the camera of the ATM DVR.
3. Check By Card Number checkbox and input the card number that is contained in the ATM

information.

4. Inthe File Type dropdown list, you can select the file type to narrow down the search scope and

search for only the video files for certain types.

5. Inthe calendar panel, click to select date you want to search.

Note: If there are video files for that camera in that day, the date which has video files will be

marked with .

6. Click Search to search the video files and the playback will start.
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6.3.2 Playing Video Files for ATM Playback

After searching the video files for the normal playback, the playback will start in the display window.

The timeline indicates the time duration for the video file.

Click on the timeline to play back the video of the specific time.

You can click **| or ** to scale up or scale down the timeline bar.

You can click t€1 or L21 on the timeline bar to go to the previous or the next time period.
8 p

You can use the mouse wheel to zoom in or zoom out on the timeline.
Please refer to Chapter 6.1 Normal Playback for the description of the playback control toolbar and

right-click menu. Some icons may not available for ATM playback.

6.4 Synchronous Playback

Purpose:

In synchronous playback, the video files can be played in synchronization.

Note: Video files from up to 16 cameras can be played simultaneously.

Steps:

1. Open the Remote Playback page.

2. Inthe camera list, check to select the cameras for playback.
Note: At least two cameras are during playback.

3. Inthe File Type dropdown list, you can select the file type to narrow down the search scope and
search for only the video files for certain types.

4. Check Synchronous Playback checkbox to enable playing the video files synchronously.
Note: Set the window division in multi-window division so that you can enable this function.
In the calendar panel, click to select date you want to search.
Click Search to search the video files and the camera under playback will start synchronous

playback.
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6.5 VCA Playback

Purpose:
You can set VCA rule to the searched video files and find the video that motion detection occurs. This
function helps to search out the video that you may be more concerned and mark it with red color.
VCA Search: Get all the related motion detection events that occurred in the pre-defined region.
Steps:
1. Open the Remote Playback page.
2. Select the camera and start the normal playback. Refer to Chapter 6.1 Normal Playback.
3.  Right-click on the display window and click VCA Search to open the VCA Search sub menu.
4. Draw the detection region.
1) Click Draw Area.
2) Click and move on the playback window to set the grid rectangle as the detection region.
Or you can click All Regions to set all the area shot by the camera as the detection region.
In the VCA Search sub menu, set the sensitivity as 1, 2, or 3.
(Optional) To delete the drawn region or line, click Delete Area to remove it.
Click Search.

The VCA events occurred in the defined area will be red marked on the timeline.

= ace

I ] |

indow 1

8. (Optional) Click Previous Event or Next Event or view the previous and next event.

6.6 Fisheye Playback

Purpose:

You can play the video files in fisheye expansion mode.
Steps:

1. Open the Remote Playback page.
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2. Select the camera and start the normal playback. Refer to Chapter 6.1 Normal Playback.
Right-click on the video and select Fisheye Expansion to enter Fisheye Expansion Mode.
Note: The mounting type of fisheye expansion in playback is set according to the mounting type
in live view.
4. You can select the expanding mode for playback as desired.
® Fisheye: In the Fisheye view mode, the whole wide-angle view of the camera is displayed.
This view mode is called Fisheye because it approximates the vision of a fish’s convex eye.
The lens produces curvilinear images of a large area, while distorting the perspective and
angles of objects in the image.
® Panorama/Dual-180° Panorama/360° Panorama: In the Panorama view mode, the
distorted fisheye image is transformed to normal perspective image by some calibration
methods.
® PTZ: The PTZ view is the close-up view of some defined area in the Fisheye view or
Panorama view, and it supports the electronic PTZ function, which is also called e-PTZ.
Note: Each PTZ view is marked on the Fisheye view and Panorama view with a specific
navigation. You can drag the navigation on the Fisheye view or Panorama view to adjust the

PTZ view, or drag the PTZ view to adjust the view to the desired angle.

Please refer to Chapter 6.1 Normal Playback for the description of the playback control toolbar and

right-click menu.
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Chapter 7 Event and Alarm Center

The information of recent alarms and events can display in the Event and Alarm Center.

Click E in Alarms and Events Toolbar to show the Alarms and Events panel.

> Failed to setup alarm, device name: access control, error code: 52.

[V Motion Detection [v Video Exception [v Alarm Input [v Device Exception

Index Alarm Time Alarm Sour Alarm Details Alarm Content Live View Send Email Note
3 2016-08-26 11:09:35 Encoding Device 10.16.6.126 Camera01 Motion Detection Alarm Start (]
2 2016-08-26 11:09:33 Encoding Device 10.16.6.126 CameraQ1 Motion Detection Alarm Stop
2 2016-08-26 11:00:49 Encoding Device 10.16.6.126 Camera01 Motion Detection Alarm Start v
2016-06-26 11:00:49 Encoding Device 10.16.6.126 Camera01 Motion Detection Alarm Stop
2018-0R-26 10 39:37 Fnending Daviea 1016 6 126 Camera01 Matinn Detaction Alarm Start "

You can click E to display the Alarm Event page.

Inclex Alarm Time

5  2016-08-26 12:41:21
4 2016-08-26 12:23:56
3 2016-08-26 12:22:53
3 2016-08-26 11:09:35
2 2016-08-26 11:09:33

||, AlarmEvent

> Failed to setup alarm, device name: Intersection, error code: 13.

Alarm Source

Encoding Device
Encoding Device
Encoding Device
Encoding Device

Encoding Device

Alarm Details
10.16.5.106 IP Camera01
10.16.6.126 Camera01
10.16.6.126 Camera01
10.16.6.126 Camera01
10.16.6.126 Camera01

Alarm Content

Motion Detection Alarm Start
Motion Detection Alarm Start
Motion Detection Alarm Stop
Motion Detection Alarm Start

Motion Detection Alarm Stop

Live View Send Email Note

2 2016-08-26 11:00:49
2016-08-26 11:00:49
1 2016-08-26 10:39:37

Encoding Device
Encoding Device

Encoding Device

10.16.6.126 Camera01
10.16.6.126 CameraQ1
10.16.6.126 Camera01

Motion Detection Alarm Start
Motion Detection Alarm Stop

Motion Detection Alarm Start

[V Motion [v Video Exception [v Alarm Input [ Device Exceptional

Note: Before you can receive the alarm information from the device, you need to click Tool->Device

Arming Control and arm the device by checking the corresponding checkbox.

Device Arming Control x

Encoding Device Storage Server
’p Al Arming Status
[~ camera a
[v access control [ ]
[V camera2 | ]

On the Alarms and Events panel, the following toolbar buttons are available:
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Clear Info Clear the information of alarms and events displayed on the list.

Enable/Disable Alarm ] ) ]
Click to enable/disable image pop-up when alarms occur.

|
o

Triggered Pop-up Image

n Audio On/Mute Click to enable/disable the audio warning for the alarm.

= Auto Hide/Lock Click to hide automatically/lock the Alarms and Events panel.

Maximize Maximize the Alarms and Events panel in a new tab page.

E Show/Hide Click to show/hide the Alarms and Events panel.

7.1 Viewing Alarms Information

Purpose:

Different alarm types can display on the panel: Motion Detection, Video Exception, Alarm Input, and

Device Exception. You can check the checkbox to enable the displaying of that type alarm.

Before you start:

To display the alarms, the event parameters need to be configured.

Steps:
1. Click Alarm tab.
2. Check the checkboxes of different alarm types in the bottom of the page.
When an alarm occurs, the alarm information, including the time, source, details and content
will display.
3. Click % to get a live view of the alarm triggered camera.
AlarmSource 10.16.6.126 Camera01
Alarm Type: Motion Detection Alarm
Previous Next Exit
You can view the live video of the triggered camera. You can click Previous or Next to view the
previous or next alarm information.
4. Click to send an email notification of the alarm to one or more receivers if the email
settings are properly configured (refer to Chapter 10.2.5 Email Settings).
5. Click under the Note column to input the description for the alarm.
6. (Optional) To clear the alarm information, click E, or right-click on an alarm log and click Clear.

7.2 Viewing Events Information

Purpose:
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The abnormal events of the client software, such as the live view failure, device disconnection, can
also display.
Steps:
1. Click Event tab.
2. Check the checkboxes of different alarm types in the bottom of the page.
The event information, including the time and details will display.

3. (Optional) To clear the event information, click !, or right-click on the event log and click
Clear.

_ ' Failed to setup alarm, device name: access control, error code: 52.

Time Description

2017-08-29 11:25:46 Failed to setup alarm, device name: access control, error code: 52
2017-08-29 11:24:42 Failed to setup alarm, device name: access control, error code: 52
2017-08-29 11:23:39 Failed to setup alarm, device name: access control, error code: 52
2017-08-29 11:22:36 Failed to setup alarm, device name: access control, error code: 52
2017-08-29 11:21:33 Failed 1o setup alarm, device name: access control, error code: 52
2017-08-29 11:20:30 Failed to setup alarm, device name: access control, error code: 52
2017-08-29 11:19:26 Failed 1o setup alarm, device name: access control, eror code: 52
2017-08-29 11:18:23 Failed to setup alarm, device name: access control, error code: 52
2017-08-29 11:17:20 Failed to setup alarm, device name: access control, error code: 52
2017-08-29 11:16:27 Failed to start remote playback! Error code 6.No record file found.
2017-08-29 11:16:17 Failed to setup alarm, device name: access control, error code: 52
2017-08-29 11:15:14 Failed to setup alarm, device name: access control, error code: 52
2017-08-29 11:14:10 Failed to setup alarm, device name: access control, error code: 52
2017-08-29 11:13:07 Failed to setup alarm, device name: access control, error code: 52
2017-08-29 11:12:04 Failed to setup alarm, device name: access control, eror code: 52
2017-08-29 11:11:01 Failed to setup alarm, device name: access control, error code: 52
2017-08-29 11:10:08 Failed to start remote playback! Error code 6.No record file found
2017-08-29 11:09:59 Failed to setup alarm, device name: access control, error code: 52
2017-08-29 11:08:54 Failed 1o setup alarm, device name: access control, error code: 52
2017-08-29 11:07:51 Failed to setup alarm, device name: access control, error code: 52
2017-08-29 11:07:24 1 Eror code 210.(Network problem has occurred.)

2017-08-29 11:06:48 Failed to setup alarm, device name: access control, error code: 52.

2017-08-29 11:05:46 Failed to setup alarm, device name: access control, error code: 52

[v Motion Detection [v Video Exception [v Alarm Input [v Device Exception

7.3 Viewing Pop-up Alarm Information

After enabling the linkage action of Notify Surveillance Center in Camera Settings, and enabling the

Enable Alarm Triggered Pop-up Image function in Alarm Event page, the alarm image will open

when the corresponding event/alarm is triggered.

AlarmSource 10.16.6.126 Camera01
Alarm Type: Motion Detection Alarm

Previous Next Exit

You can view the live video of the triggered camera.

You can click Previous or Next to view the previous or next alarm information.
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Chapter 8 E-map Management

Purpose:
The E-map function gives a visual overview of the locations and distributions of the installed cameras.
You can get the live view of the cameras on the map, and you will get a notification message from

the map when alarm is triggered.

Click " on the control panel, or click View->E-map to open the E-map page.

Q
10.33.3.159 ~ LA L
& 10.33.3.159_Camera01

@ 10.33.3.159_Camera02
@ 10.33.3.159_Camera03
@& 10.33.3.159_Camera04
) 10.16,6.126 ~
@ 10.16.6.126_Camera01
= Intersection v
£ 10.16,5.106 v

1 2

Map Provie Edit bp

E-map Page
1 Group List
2 Map Display Area
3 E-map Toolbar

8.1 Adding an E-map

Purpose:

An E-map needs to be added as the parent map for the hot spots and hot regions.
Steps:

1. Open the E-map page.

2. Select a group for which you want to add a map.

3. Click Add Map in the Map Display Area to open the map adding window.
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Add Map X

Map Name:

Path:

OK Cancel

4. Input a descriptive name of the added map as desired.

5. Click | and select a map file from the local path.

6. Click OK to save the settings.

Notes:

® The picture format of the map can only be *.png, *.jpg or *.bmp.

® Only one map can be added to a group.

The added map displays in the Map Display Area. Use the mouse wheel or click '* or |, to zoom
in or zoom out on the map. You can drag the yellow window in the lower-right corner or use the

direction buttons and zoom bar to adjust the map area for view.

10.33.3.169 -~ e
) Map < >

& 10.33.3.159_Camera01 v

@& 10.33.3.169_Camera02 . 5
@ 10.33.3.159_Camera03

@ 10.33.3.159_Camera04 |

[ 10.166.126 A~ ; of B
@ 10.16.6.126_Camera01 heihi l > Roxbury ioh Pe
(= Intersection v I

[ 10.16.5.106 v

dge Ski Center *
4 ~ * Indian Head

Saugertie

Sundown |

Map Prvew Ect Map 0w R R Y& B e  Search Hot spot.. (@]

Click the button Modify Map or Map Preview in the E-map toolbar to enter the map editing mode or
map preview mode.

E-map Toolbar in Map Editing Mode:

MapProview  Edit Map R Ny e R B w  search Hotspot.__ |
E-map Toolbar in Map Preview Mode:
= L & o)

On the E-map page, the following toolbar buttons are available:

|

Modify Map ‘ Modify the map information, including the map name and file path.
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Delete Map Delete the current map.

m Add Hot Spot Add a camera as the hot spot on the map.

Modify Hot Spot Modify the information of the selected hot spot.
Delete Hot Spot Delete the selected hot spot.

@ Add Hot Region Add a map as the hot region on the current map.
Modify Hot Region Modify the information of the selected hot region.
m Delete Hot Region Delete the selected hot region.

! Clear Alarm Info Clear the alarm information displayed on the map.
E2d | Back to Parent Map Go back to the parent map.

8.2 The Hot Spot Function

Purpose:
You can add the cameras as hot spots on the map. The hot spots show the locations of the cameras,
and you can also get the live view and alarm information of the surveillance scenarios through the

hot spots.

8.2.1 Adding Hot Spots

Adding Cameras as Hot Spots

Steps:

1. Click Edit Map in the E-map toolbar to enter the map editing mode.
r

2. Click ﬂ in the toolbar to open the Add Hot Spot window.

Add Hot Spot X

[ Linked Camera Hot Spot Name Hot Spot Color
camera_Camera01 camera_Camera01 W Green
OK Cancel

Check the checkboxes to select the cameras to be added.

(Optional) Click the Hot Spot Name or Hot Spot Color field to edit the name and color.

Click OK to save the settings.

The camera icons are added on the map as hot spots and the icons of added cameras changes
from @ to ‘t in the group list. You can drag the camera icons to move the hot spots to the
desired locations.

You can also drag the camera icons from the group list to the map directly to add the hot spots.
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8.2.2 Modifying Hot Spots

Purpose:

You can modify the information of the added hot spots on the map, including the name and the

color.

Steps:

1.
2.

Click Edit Map in the E-map toolbar to enter the map editing mode.

Select the hot spot icon on the map and click in the toolbar, or right-click the hot spot icon
and select Modify, or double-click the hot spot icon on the map to open the Modify Hot Spot
window.

Modify Hot Spot x

Hot Spot Name: rcamera_Cameram
Linked Camera:

~
[v camera_Camera01

Hot Spot Color: 4y Green v

OK Cancel

Edit the hot spot name in the text field and select the color, and the linked camera.
Click OK to save the new settings.

To delete the hot spot, select the hot spot icon and click in the toolbar, or right-click the hot
spot icon and select Delete.

8.2.3 Previewing Hot Spots

Steps:

1. Click Map Preview in the E-map toolbar to enter the map preview mode.

2. Double-click the camera hot spots, or right-click it and select Live View to start live view of the
cameras.

3. Ifthereis any alarm triggered, an icon ! will appear and twinkle near the hot spot. Click the

alarm icon, and you can check the alarm information, including alarm type and triggering time.

Note: To display the alarm information on the map, the Notify Surveillance Center action needs to be

set as the alarm linkage action for the camera. For details, refer to Chapter 4 Camera Settings.
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8.3 The Hot Region Function

Purpose:

The hot region function links a map to another map. When you add a map to another map as a hot
region, an icon of the link to the added map is shown on the main map. The added map is called child
map while the map to which you add the hot region is the parent map.

Note: A map can only be added as the hot region for one time.

8.3.1 Adding Hot Regions

Before you start:

Add a map to another group.

Steps:

1. Click Edit Map in the E-map toolbar to enter the map editing mode.
2. Select an added map as the parent map.

)
3. Click in the toolbar to open the Add Hot Region window.

[ Linked Map Hot Region Name Hot Region Colot
[0 01 @ Green
OK Cancel
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Check the checkbox to select the child map to be linked.

(Optional) Click the Hot Spot Name or Hot Spot Color field to edit the name and color.

Click OK to save the settings.

The child map icons are added on the parent map as the hot regions. You can drag the child map

icons to move the hot regions to desired locations.

8.3.2 Modifying Hot Regions

Purpose:

You can modify the information of the hot regions on the parent map, including name, color, icon,

etc.

Steps:

1. Click Edit Map in the E-map toolbar to enter the map editing mode.

2. Select the hot region icon on the parent map and click in the toolbar, or right-click the hot
spot icon and select Modify, or double-click the hot region icon to open the Modify Hot Region
window.

Hot Region Name:  [01
Linked Map:
v o1
Hot Region Color: [l Green -
OK Cancel
Edit the hot region name in the text field and select color, icon and linked child map.
4. Click OK to save the new settings.

To delete the hot region, select the hot region icon and click m in the toolbar, or right-click
the hot spot icon and select Delete.

8.3.3 Previewing Hot Regions

Steps:

1.
2.

Click Map Preview in the E-map toolbar to enter the map preview mode.
Click the hot region icon to go to the linked child map.
The hot spots can also be added on the hot regions.
. .
Click B2 in the toolbar to go back to the parent map.

Click ! in the toolbar to clear the alarm information.
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Chapter 9 Log Search

Purpose:

You can search and check the log files of the client software stored on the local PC. Three types of log

files are provided: alarm log, operation log, and system log.

® Operation Log: The log files of the operations of Guarding Vision Client Software, such as
starting live view, starting playback, etc.

® System Log: The log files of user login and logout.

® Alarm Log: The log files of all the alarms received by the client.

Click on the control panel to open the Log Search page.

Log Type: Alarm Log ~  User: Al Users ~  Start Time: 2016-08-25 00:00:00 =
Minor Type: Al ~ Group: Al Groups ~ End Time: 2016-08-25 23:59:59
Camera: Al Cameras v Q. Search Backup
Index  Operation Time Content User Name Alarm Details Event  Note

9.1 Searching Log Files

Steps:

Open the Local Log Search page.

Select the log type as Operation Log, System Log, or Alarm Log.
According the log type, select the minor type for the log.

Set the user, camera group, and camera for the logs to search.
Specify the start time and end time for search

Click Search.

The log files between the start time and end time will display on the list.

o vk wnN R

You can check the operation time, content and other information of the logs.

Note: Please narrow the time range or filter the log type for search if there are too many log files.
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Index Operation Time Content User Name Server Name Camera Name Event
498 2016-08-26 14:58:19  Stop Live View admin 10.16.6.126 Camera01
499 2016-08-26 15:11:20  Start Live View admin 10.16.6.126 Camera01
500 2016-08-26 15:35:24  Stop Live View admin 10.16.6.126 Camera01
501 2016-08-26 15:48:15  Add Map admin

502 2016-08-26 15:54:43  Add Map admin

503 2016-08-26 15:55:13  Add Hot Region admin

504 2016-08-26 15:58:14  Add Hot Spot admin 10.16.6.126 Camera01
505 2016-08-26 16:03:39  Add Hot Spot admin 10.33.3.159 Camera01
506 2016-08-26 16:03:55  Start Live View admin 10.33.3.159 Camera01
507 2016-08-26 16:03:58  Stop Live View admin 10.33.3.159 Camera01
508 2016-08-26 16:05:49  Start Live View admin 10.16.6.126 Camera01
509 2016-08-26 16:06:07  Stop Live View admin 10.16.6.126 Camera01
510 2016-08-26 16:06:27  Add Map admin

511 2016-08-26 16:06:30  Add Hot Spot admin 10.16.5.106 IP Camera01
512 2016-08-26 16:06:33  Modify Hot Spot admin 10.16.5.106 IP Camera01
513 2016-08-26 16:06:50  Add Hot Region admin

514 2016-08-26 16:07:12  Start Live View admin 10.16.5.106 IP Camera01
515 2016-08-26 16:11:15  Motion Detection Settings admin 10.16.5.106 IP Camera01
516 2016-08-26 16:15:24  Stop Live View admin 10.16.5.106 IP Camera01
517 2016-08-26 16:16:36  Add Hot Region admin

518 2016-08-26 16:24:05 _ Local Log Search admin

9.2 Backing up Log Files

Purpose:

You can export the log files for backup.

Steps:

1. Set the condition and search the log file.

2. Click Backup to open the Log Backup window.

File Path:

Backup Cancel

3. Click I and select a local saving path and set a name for the file.
4. Click Backup to export the selected log file for backup.

You can click File->Open Log File to check the information of the backup log files on local PC.
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Chapter 10 Account Management and

System Configuration

10.1 Account Management

Purpose:

You can add multiple user accounts to the client software, and assign different permissions for

different users if needed.

Click 1 on the control panel, or click Tool->Account Management to open the Account

Management page.

© Add 2 Modify
[ nce Name Type
1 admin Super User

Note: The user account you registered to log in to the software is set as the super user.

10.1.1 Adding the User

Steps:

1. Open the Account Management page.

2. Click Add to open the Add User window.

Password: |

User Type: Administrator

r

’f./ Al

[v

~

v
v
v
v
v

1%
v
v
v
v

v

Live View
PTZ Control

[v Capture

v Record

[V Camera Settings

v Play Back Remote Record File(s)

[ Download Remote Record File(s)

Remote Recording

[v Synchronization
[V Backup Snapshot File(s)
[v Backup Record File(s)

v Device Parameters Settings

Send Email

v User Name: [

Confirm Password: [

= test 01
- [v camera

[V camera_Camera01

Default

3. Select the user type from the drop-down list.

Two types of user accounts are selectable:

Administrator: The administrator account has all permissions by default, and can modify the

passwords and permissions of all operators and its own account.

Operator: The operator account has no permission by default and you can assign the
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permissions manually. An operator can only modify the password of its own account.
4. Input the user name, password and confirm password as desired.

We highly recommend you to use a strong password to ensure your data security.

Check the checkboxes to assign the permissions for the created user.

(Optional) Click Default to restore the default permissions of this user.

Click Save to save the settings.

® A user name cannot contain any of the following characters: /\ : * ? “< > [. And the length
of the password cannot be less than 6 characters.

®  For your privacy, we strongly recommend changing the password to something of your own
choosing (using a minimum of 8 characters, including upper case letters, lower case letters,
numbers, and special characters) in order to increase the security of your product.

®  Proper configuration of all passwords and other security settings is the responsibility of the
installer and/or end-user.

Note: Up to 50 user accounts can be added for the client software.

10.1.2 Managing the User

Purpose:

After created successfully, the user account is added to the user list on the Account Management
page. You can edit or delete the information of the user accounts.

To edit the information of the user, select the user from the list, and click Modify, or double-click the
user name to enter the Modify User window.

To delete the information of the user, select the user from the list, and click Delete.

Note: The super user cannot be deleted and only the password of the super user can be edited.

10.2 System Configuration

Purpose:

The general parameters, live view and playback parameters, image parameters, file saving paths, icon
of live view and playback toolbar settings, keyboard and joystick shortcuts, alarm sounds, email
settings and video intercom parameters can be configured.

Click = on the control panel,
or click System->System Configuration to open the System Configuration page.
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System Configuration x
¥ General B
e — Set frequently used parameters
™ image (e.g., log expiry date, performance, etc.)
= File
Log Expiry Date: One Month ¥
[ Aarm sound
Maximum Mode: Full Screen v
Email
Pre-Play for: 3 min. v
Network Performance: Low  Middle = High
CPU Performance: Low  Middle = High

[V Enable Auto-login
[V Prioritize Playback of Video Files on Storage Server
[ Resume Latest Live View Status after Restart

Auto Time Adjustment: 00:00:00

Default Save

Note: You can click Default to restore the defaults of all the system configurations.

10.2.1 General Settings

Purpose:

You can set the frequently-used parameters, including the log expiry time, network performance, etc.

Steps:
1.
2.
3.

Open the System Configuration page.
Click General tab to enter the General Settings page.

Set frequently used parameters
(e.g., log expiry date, performance, etc.)

Log Expiry Date: One Month v
Maximum Mode: Full Screen v
Pre-Play for: 3 min. v
Network Performance: Low  Middle High
CPU Performance: Low  Middle High

[V Enable Auto-login
[v  Prioritize Piayback of Video Files on Storage Server
[V Resume Latest Live View Status after Restart

[ Auto Time Adjustment: 00:00:00

Configure the general parameters.

Parameters

Descriptions

Log Expiry Date

The time for keeping the log files, once exceeded, the files will be deleted.

Maximum Mode

The maximum mode of the video in live view or playback. It can be set as
Full Screen, 4:3, or 16:9.

Pre-Play for

Set the pre-play time for instant playback. By default, it is 3 minutes.

Network Performance

The current network conditions. It can be set as Low, Middle, or High.

CPU Performance

The CPU performance. It can be set as Low, Middle, or High.

Enable Auto-login

Log into the client software automatically.
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Prioritize Playback of ) i )
. . Play back the video files recorded on the storage server preferentially.
Video Files on Storage ] ] ] ]
2 Otherwise, play back the video files recorded on the local device.

erver

Resume Latest Live View o . . .
Resume the latest live view status after you log in to the client again.
Status after Restart

Auto Time Adjustment Adjust the time automatically at a specified time point.

4. Click Save to save the settings.

10.2.2Image Settings

Purpose:

You can set the image parameters for live view and playback, such as highlight, VCA rule, etc.
Steps:

1. Open the System Configuration page.

2.  Click Image tab to enter the Image Settings page.

Set image parameters for the client
(e.g., VCA rule and play performance)

[ Enable Highlight
[v VCARule

v Auto-change Stream Type

3.  Configure the image parameters.

Parameters Descriptions

L Mark the detected objects with green rectangles in live view and
Enable Highlight
playback.

VCA Rule Display the VCA rule in the live view.

Change the video stream (main stream or sub-stream) automatically in
live view according to window division. When the window division is

Auto-change Stream Type o . . . )
larger than 9, it will switch to sub-stream automatically. Or it remains

main stream.

4.  Click Save to save the settings.

10.2.3 File Saving Path Settings

Purpose:

The video files from manual recording, the captured pictures and the system configuration files are
stored on the local PC. You can set the saving paths of these files.

Steps:

1. Open the System Configuration.

2. Click File tab to enter the File Saving Path Settings page.
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Set file saving path
(e.g., video file, picture, and device configuration file, etc.).

Saving Path of Video File:
IApplications/Client.app/Contents/MacOS/Fil -
Saving Path of Picture:
JApplications/Client.app/Contents/MacOS/Fil -
Saving Path of Configuration File:

lient.app/C OSIFil

3. Click | and select a local path for the files.
4. Click Save to save the settings.

10.2.4 Alarm Sound Settings

Purpose:

When the alarm, such as motion detection alarm, video exception alarm, etc., is triggered, the client
can be set to give an audible warning and the sound of the audible warning can be configured.
Steps:

1. Open the System Configuration page.

2. Click Alarm Sound tab to enter the Alarm Sound Settings page.

Set alarm sound

(e.g. motion detection alarm,video exception alarm, alarm input and device exception alarm)

Motion Detection:

motion.wav >
Video Exception:

video_abnormal.wav | %9
Alarm Input:

alarm_input.wav - | %9

Device Exception:

device_abnormal.wav e |

3. Select the alarm sound.

There are four pre-defined alarm sound type in the list. You can click |~ and select the audio
files from the local path for different alarms.

4. (Optional) Click ¥ fora testing of the audio file.
5. Click Save to save the settings.

Note: The format of the audio file can only be *wav.

10.2.5 Email Settings

Purpose:

An email notification can be sent when a system alarm occurs. To send the email to some specified
receivers, the settings of the email need to be configured before proceeding.

Steps:
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1. Open the System Configuration page.
2. Click Email tab to enter the Email Settings page.

Set email parameters ircluding sender and recipient.

SMTP Server:
Encryption Type: ® Not-Ercrypted ( SSL [~ STARTTLS

Port:

25

Password:

Sender's Address:

|
[
User Name: [
|
(
|

Recever's Address:

Send Test Email

3. Input the required information.
SMTP Server: Input the SMTP Server address.
Encryption Type: Select the encryption type.
Port: Input the communication port of email service. The port is 25 by default.
User Name: Input the user name of the sender email address if Server Authentication is
checked.
Password: Input the password of the sender Email address if Server Authentication is checked.
Sender’s Address: Input the email address of the sender.
Receiver’s Address: Input the email address of the receiver.
(Optional) Check Enable SSL checkbox to increase the security of email sending.
(Optional) Click Send Test Email to send an email to the receiver for test.

Click Save to save the settings.
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Appendix

System Requirements

® Client Requirements

Processor Intel® Core™ i3 3GHz
Recommended Memory 4 GB of RAM
Video Card AMD Radeon HD 6470M 256M
Processor Intel® Core™ i7 2GHz
High Performance Memory 4 GB of RAM
Video Card AMD Radeon HD 6490M 256M
® Maximum Number of Cameras Viewed per Client under Different System Requirements
Frame Maximum Number of Cameras Viewed Simultaneously
Encoding Bit Rate
Resolution Rate
Format (Mbps) Recommended High Performance
(fps)
720P 1 25 13 18
H.264 1080p 4 25 4 5
8 MP 16 25 1 2
720p 1 25 11 19
H.264+ 1080p 3 25 5 6
3 MP 4 25 3 6
720p 1 25 3 7
H.265 1080p 3 25 1 3
3 MP 4 25 1 3
720p 0.5 25 7 15
H.265+ 1080p 1 25 3 6
3 MP 2 25 1 3

Note: The above parameters are estimated and for reference only. Under the same resolution and frame rate,
the bitrate of different camera manufacturers may be different. Moreover, the decoding performance may also

be different for different manufacturers.

Specifications
Model Guarding Vision
Database SQLite
User Support up to 50 users and one super user
E-map Support up to 256 maps
Client General
Encoding Device Support up to 256 encoding devices
Decoding Device Support up to 64 decoding devices
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Group Support up to 256 groups
Support up to 64 channels for each group
Channel Support up to 1024 channels for all groups
Storage Server Support up to 16 Storage Servers

Stream Media Server Support up to 16 Stream Media Servers

Live View Support up to 64-ch live view at a time

Video Playback Support up to 16-ch playback at a time

Synchronous Playback Support up to 16-ch synchronous playback

FAQ

Live View

Question:

How to get the live view for the channels in the remote client?

Answer:

Steps:

1. Add the device into the software device list; please refer to Chapter 3.1 Adding the Device for
more details.

2. Add cameras into a group. Please refer to Chapter 3.2 Group Management for detailed
information.

3. Open the Main View page from the Control Panel, and drag the camera from the group list on

the left side to the display window. Refer to Chapter 5.1 Starting and Stopping the Live View.

Playback

Question: How to search for video files recorded of certain event mode?

Answer:

Steps:

1. Go to Event Search page and select an event type: motion or alarm (i.e. alarm input).

2. Choose a camera in the group and specify a start time, then click Search.

3. Select a window, and double-click a video file from the search results list to play the video of

that channel.

Configuration

Question: How to set encoding parameters in the device configuration?
Answer:
The encoding parameters should be set separately for each camera, and it is configured in Camera

Settings setup page. Click ®= on the control panel to enter the Camera Settings page.
0104001070914
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